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Conventions used in this guide
TIP: Tips provide helpful hints or shortcuts.

NOTE: Notes provide important information to explain a concept or to complete a task.

CAUTION: Cautions indicate procedures that you should follow to avoid losing data or damaging
the product.

WARNING! Warnings alert you to specific procedures that you should follow to avoid personal
injury, catastrophic loss of data, or extensive damage to the product.
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Product overview

HP Officejet Pro X451 MFP Series models

Officejet Pro X451dn models

CN459A

Paper handling:

● Tray 1 (50-sheet capacity for 75 GSM or
20 lb. Bond paper)

● Tray 2 (500-sheet capacity for 75 GSM or
20 lb. Bond paper)

● Optional Tray 3 (500- sheet capacity for
75 GSM or 20 lb. Bond paper)

● Standard output bin (250- sheet capacity
for 75 GSM or 20 lb. Bond paper)

● Automatic duplex printing

Supported operating systems:

● Windows XP, 32-bit (Service Pack 2 or
Higher)

● Windows Vista, 32-bit and 64-bit

● Windows 7, 32-bit and 64-bit

● Windows 8, 32–bit and 64–bit

● Mac OS X v10.6 and later

NOTE: For additional information on
Operating System support, see Supported
operating systems and printer drivers for
Windows.

Connectivity:

● Hi-Speed USB 2.0

● 10/100 Ethernet LAN connection

Officejet Pro X451dw models

CN463A

Has the same features as the Officejet Pro X451dn Series, but includes the following:

● 802.11 B/G/N Single Band wireless adapter

● HP Wireless Direct printing
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HP Officejet Pro X551 MFP Series models

Officejet Pro X551dw models

CN596A

Paper handling:

● Tray 1 (50-sheet capacity for 75 GSM or
20 lb. Bond paper)

● Tray 2 (500-sheet capacity for 75 GSM or
20 lb. Bond paper)

● Optional Tray 3 (500- sheet capacity for
75 GSM or 20 lb. Bond paper)

● Standard output bin (250- sheet capacity
for 75 GSM or 20 lb. Bond paper)

● Automatic duplex printing

Supported operating systems:

● Windows XP, 32-bit (Service Pack 2 or
Higher)

● Windows Vista, 32-bit and 64-bit

● Windows 7, 32-bit and 64-bit

● Windows 8, 32–bit and 64–bit

● Mac OS X v10.6 and later

NOTE: For additional information on
Operating System support, see Supported
operating systems and printer drivers for
Windows.

Connectivity:

● 802.11 B/G/N Single Band wireless adapter

● Hi-Speed USB 2.0

● HP ePrint

● HP Wireless Direct printing

Print:

● Plug and Print USB Drive printing (no computer
required)

IMPORTANT: This printer is designed to be used on a level surface. Operating the printer when not
level could result in inaccurate printer messaging about the amount of ink remaining in cartridges.

Environmental features

Duplex printing Automatic duplex printing is available with the Officejet Pro X451 and Officejet Pro X551.
Duplex printing saves the environment and saves you money.

Print multiple pages per
sheet

Save paper by printing two or more pages of a document side-by-side on one sheet of paper.
Access this feature through the printer driver.

Recycling Reduce waste by using recycled paper.

Recycle ink cartridges by using the HP Planet Partners return process.

Energy savings Sleep modes and timer options enable this product to quickly go into reduced power states
when not printing, thus saving energy.

NOTE: Additional energy savings may be realized by turning off the printer if it will not be used for
more than four hours.
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Accessibility features
The product includes several features that aid users with limited vision, hearing, dexterity or strength.

● Online user guide that is compatible with text screen-readers.

● Ink cartridges can be installed and removed using one hand.

● All doors and covers can be opened using one hand.

Product views

Front view (X451 Series)

1

7

2
43

5

6

1 Control panel

2 Output eject flap.

3 Output bin

4 Output bin extension

5 Tray 2 (Main paper tray)

6 On/Off button

7 Ink cartridge door
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Front view (X551 Series)

1

7

8 2
4

3

5

6

1 Control panel

2 Output bin door

3 Output bin

4 Output bin extension

5 Tray 2 (Main paper tray)

6 On/Off button

7 Ink cartridge door

8 USB 2.0 Host port that accepts USB storage devices for Plug and Print USB Drive printing.
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Back view

4

5

3

1

2

1 Left door (access for clearing jams)

2 Tray 1 (Multi-purpose tray)

3 Power connection

4 Hi-Speed USB 2.0 ports

5 Ethernet port
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Interface ports

1

2

3

1 Ethernet port

2 USB Device port accepts a USB cable from a PC (alternative to Network and Wireless connections).

3 USB Host port accepts USB storage devices for Plug and Print (Officejet Pro X551 only).
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Serial number and model number location
Open the ink cartridge door to view the serial number and product model number label.
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Control panel layout (X451 Series)

1  Display screen area

2 Help button: provides access to the product help system.

3 Wireless button: provides a number of menu items to view and adjust network settings on wireless models.

4 HP ePrint button: provides quick access to HP Web Services features, including HP ePrint.

HP ePrint is a tool that prints documents by using any e-mail enabled device to send them to the product’s e-mail
address.

5 Cancel button: cancels the current job or exits the current screen.

NOTE: This button illuminates only when the current screen can use this feature.

6 Back button: returns to the previous screen

NOTE: This button illuminates only when the current screen can use this feature.

7 Home button: provides quick access to the Home screen. This button only illuminates only when the current
screen can use this feature.
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Buttons on the Home screen (X451 Series)

The Home screen provides access to the product features, and it indicates the product status.

NOTE: Depending on the product configuration, the features on the Home screen can vary. The
layout might also be reversed for some languages.

1 Setup  button: provides a number of menu items to view and adjust product settings.

2 Job Status button: allows you to view the status of any current print jobs.

3 Ink Information button: provides information on the ink levels.
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Control panel help system

The product has a built-in Help system that explains how to use each screen. To open the Help
system, touch the Help  button to the right of the control panel (Officejet Pro X451) or the upper-right
corner of the control panel (Officejet Pro X551).

For screens that contain settings for individual tasks, the Help opens to a topic that explains the
options for that task.

Control panel layout (X551 Series)

Jan 00 00 00:00a

1  Display and touch screen area

2 Help button: provides access to the product help system

NOTE: This button illuminates only when help is available for the current screen or feature.

3 Right arrow button: moves the cursor to the right or moves the display image to the next screen

NOTE: This button illuminates only when the current screen can use this feature.

4 Cancel button: cancels the current job or exits the current screen.

NOTE: This button illuminates only when the current screen can use this feature.

5 Back button: returns to the previous screen

NOTE: This button illuminates only when the current screen can use this feature.

6 Left arrow button: moves the cursor to the left

NOTE: This button illuminates only when the current screen can use this feature.
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7 Home button: provides quick access to the Home screen. This button only illuminates only when the current
screen can use this feature.

8 Wireless light: indicates the wireless network is enabled. The light blinks while the product is establishing a
connection to the wireless network. When connected, the light stops blinking and stays lit.
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Buttons on the Home screen (X551 Series)

The Home screen provides access to the product features, and it indicates the product status.

NOTE: Depending on the product configuration, the features on the Home screen can vary. The
layout might also be reversed for some languages.

Jan 00 00 00:00a

1 Web Services  button: provides quick access to HP Web Services features, including HP ePrint.

HP ePrint is a tool that prints documents by using any e-mail enabled device to send them to the product’s e-mail
address.

2 Network  button: provides access to network settings and information. From the network settings screen, you
can print the Network Summary page, set up a wireless network connection, and access advanced network
settings.

NOTE: The wireless network feature is only available on select models.

NOTE: When you are connected to a wireless network, this icon changes to a set of signal strength bars.

3 Eco Settings  button: provides a list of options to help reduce energy and paper consumption.

4 Supplies  button: provides information about supplies status. From the supplies summary screen, you can
print the Supplies Status page.

5 Setup  button: provides a list of available fax reports and settings.

6 Plug and Print button: provides access to the Plug and Print USB Drive printing feature (no computer is required).
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7 Status display. When the product is idle, this area of the control panel displays the time and date and allows for
access to the time and date settings by touching this area. When the product is processing a job, job status
information replaces the time and date display.

8 Apps button: provides access to the Apps menu to print directly from select Web applications
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Control panel help system

The product has a built-in Help system that explains how to use each screen. To open the Help
system, touch the Help  button in the upper-right corner of the screen.

For screens that contain settings for individual tasks, the Help opens to a topic that explains the
options for that task.

If the product alerts you of an error or warning, touch the Help  button to open a message that
describes the problem. The message also contains instructions to help solve the problem.
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2 Control panel menus

● Status menu

● Apps

● Plug and Print (Officejet Pro X551 models only)

● Setup Menu

Status menu
To access the Status menu, select Status from the Home screen on the Control Panel. The Status
menu is available on Officejet Pro X451models only.

Menu item Sub-menu item Sub-menu item Description

Job Status   View information on currently processing jobs on the
product.

Ink Information Estimated Levels  View a graphic representation of the ink cartridge
levels for all the cartridges.

Cartridge Info Magenta

Cyan

Yellow

Black

View a graphic representation of the ink cartridge
level for each cartridge individually.

Print Report  Print the Printer Status Report

Network Summary Wired  View a summary of the product's wired network
settings; IP address, hostname, and Mac address.

Wireless  View a summary of the product's wireless network
settings; IP address, hostname, and Mac address.

Apps
Use the Apps menu (HP OfficeJet Pro X551 models only) to enable Web Services on the product and
use HP ePrint and print Apps.

Plug and Print (Officejet Pro X551 models only)
Use the Plug and Print menu to print directly from a USB Flash or Hard Drive device. For more
information on printing with Plug and Print, see Plug and Print USB Drive Printing.
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Setup Menu
To open this menu, press (X451 Series) or touch (X551 Series) the Setup  button from the control
panel. The following sub menus are available:

● Network

● HP Web Services (HP OfficeJet Pro X451 models only)

● Device Setup

● Tools

● Print Reports
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Network menu
In the following table, items that have an asterisk (*) indicate the factory default setting.

NOTE: Wireless menu options are only available on products that support wireless connectivity. For
more information, refer to the Product Basics chapter of this user guide.

Menu item Sub-menu item Sub-menu item Description

Wireless Menu
(wireless products only)

NOTE: You can also
access this menu by
touching the Wireless

 button on the control
panel.

On

Off

 Enables or disables the wireless network feature.

Wireless Direct
(wireless products only)

On

On With Security

Off

 Configure the Wireless Direct settings for the product.

Wireless Setup Wizard
(HP Officejet Pro X551
MFP Series)

Print Guide

Continue

 Guides you through the steps to set up the product on a
wireless network.

Wi-Fi Protected Setup
(wireless products only)

Continue Push Button

PIN

If your wireless router supports WPS, use this method to
set up the product on a wireless network. This is the
simplest method.

View Network
Summary

View Wired

View Wireless

 Prints a summary of your network settings.

Print Wireless Test
Report(wireless
products only)

  Prints a wireless test report.

Print Network
Configuration Page

  Prints a report of your network configuration settings.

Advanced Setup Link Speed Automatic*

10 Full

10 Half

100 Full

100 Half

Sets the link speed. After setting the link speed, the
product automatically restarts.

 IP Settings Automatic (DHCP)*

Manual (Static)

Set whether the product's IP setting are configured
automatically with DHCP or set manually.

 IPv6 On*

Off

Enable or disable the IPv6 protocol on the product.

 Hostname OK

Change

Use this setting the change how the product is identified
on the network.
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Menu item Sub-menu item Sub-menu item Description

 Legacy Default IP On

Off

 

Restore Network
Defaults

  Resets all network configurations to their factory defaults.
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HP Web Services menu (Officejet Pro X451 models only)

Menu item Sub-menu item Description

Enable Web Services Yes

No

Enables HP Web Services so you can use HP ePrint and the Apps menu.

HP ePrint is a tool that prints documents by using any e-mail enabled
device to send them to the product’s e-mail address.

Use the Apps menu to print directly from select Web applications.
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Device Setup menu
In the following table, items that have an asterisk (*) indicate the factory default setting.

Menu item Sub-menu item Sub-menu item Sub-menu item Description

Preferences Time/Date   Sets the time format, current time, date format, and
current date for the product.

 Language List of available
control-panel
display
languages.

 Sets the language in which the control panel displays
messages and product reports.

 Country/Region Displays a list of
available
countries and
regions.

 Selects which country/region the product is used.

 Screen Brightness   Adjust the sliding bar to control the screen brightness
on the Control Panel

 Sound Effects
Volume

Soft*

Loud

Off

 Adjusts the product's sound effect level.

 Faster Browsing On

Off*

 Sets the browsing speed to go faster than the default.

Default Tray Auto

Tray 1

Tray 2*

Tray 3 (Accessory)
only if installed

  Sets the default tray to print from.

Default Paper in
Tray

Tray 1 Default Paper
Size

Letter (8.5 x
11in.)

A4 (297 x 210
mm)

...

For a complete
list of paper sizes,
see Supported
paper sizes.

Select the default paper size for Tray 1 (multi-purpose
tray).
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Menu item Sub-menu item Sub-menu item Sub-menu item Description

  Default Paper
Type

Plain Paper

Premium Inkjet

...

For a complete
list of paper sizes,
see Supported
paper types and
tray capacity .

Sets the paper type for printing internal reports, or any
print job that does not specify a type.

 Tray 2 Default Paper
Size

Letter (8.5 x
11in.)

A4 (297 x 210
mm)

...

For a complete
list of paper sizes,
see Supported
paper sizes.

Select the default paper size for Tray 2 (main paper
tray).

  Default Paper
Type

Plain Paper

Premium Inkjet

...

For a complete
list of paper sizes,
see Supported
paper types and
tray capacity.

Sets the paper type for printing internal reports, or any
print job that does not specify a type.

 Tray 3 Default Paper
Size

Letter (8.5 x
11in.)

A4 (297 x 210
mm)

...

For a complete
list of paper sizes,
see Supported
paper sizes.

Sets the default paper size for the optional Tray 3.

  Default Paper
Type

Plain Paper

Premium Inkjet

...

For a complete
list of paper sizes,
see Supported
paper types and
tray capacity.

Sets the type of paper for printing internal reports, or
any print job that does not specify a type.
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Menu item Sub-menu item Sub-menu item Sub-menu item Description

Tray Lock Tray 1

Tray 2

Tray 3

None*

  Tray Lock is a feature that “locks" a tray so that the
only time the printer will draw from that tray is when it
is specifically requested. This is useful when putting
special paper in a tray, such as letterhead. If using
“Automatically Select" for the paper source and Tray 1
is locked, the printer will only draw from the remaining
trays, either Tray 2 or optional Tray 3, if it is installed.
Printing can still be done from the locked tray, but the
source must be specified. Tray 1 lock may be
overridden under certain conditions.

Duplex On Bind on Long
Edge

Bind on Short
Edge

 Selects whether to turn duplexing on or off. If on,
select to have the page indented on the long edge or
short edge of the paper for binding.

 Off    

Ink Low Warning
Level

Automatic

Custom

  Determines when the Low Ink warning message
appears on the control panel. Choose Custom to
select a cartridge color and ink level value from 1–99.

Power Handling Standby 5 Minutes

10 Minutes *

15 Minutes

30 Minutes

1 Hour

 Determines when to put the product in Standby mode.

 Sleep After
Standby

15 Minutes

30 Minutes

1 Hour

2 Hours *

 Determines when to put the product to sleep after it
has been put into Standby mode.

 Auto Power Off
(HP Officejet Pro
X451 MFP Series)

Never*

2 hours after
Standby

4 hours after
Standby

8 hours after
Standby

12 hours after
Standby

 Sets the product to power down after a specific
amount of time.

 Schedule On/Off Schedule On

Schedule Off

 Schedules a time to automatically turn the product on
or off.

24 Chapter 2   Control panel menus ENWW



Menu item Sub-menu item Sub-menu item Sub-menu item Description

Print Settings Personality Automatic*

PCL5 Only

PCL6 Only

PS Only

 Sets the printer language. By default, the product
automatically selects which language to use.

 Copies   Sets the number of copies (0–99) to make when the
Copy button is touched. The default value is 1.

 Quality General Office

Professional*

Presentation

 Sets the default print quality.

 PCL Configuration Form Length

Orientation

Font Number

Font Pitch1

Font Point Size1

Symbol Set

Append CR to LF

 Sets the text attributes for the printer control language
being used.

 Print Postscript
Error

On

Off

 Sets the product to print any postscript errors that
occur.

1 For HP Officejet Pro X451 MFP Series products, font pitch and font point size settings can not be made at the product
control panel. Changes to these settings must be made using the EWS.
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Tools menu
Use the Tools menu to improve the product's print quality and view estimated ink levels.

Menu item Description

Display Estimated Ink
Levels

Displays a graph of how much ink has been consumed for each cartridge.

Clean Printhead Use this feature to clean, adjust, and align the printheads. Follow the on-screen instructions to correctly
improve the product's print quality.

Cartridge Chip Information The cartridge chip stores anonymous information about the usage of the product.

Control Panel Lock Use this feature to lock the product's control panel and prevent unauthorized use of the product.

Clean Ink Smear Use this feature to solve print quality problems caused by ink smearing on printed pages.

Restore Factory Defaults Sets all settings to the factory default values
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Print Reports menu
Use the Print Reports menu to print reports that provide information about the product.

Menu item Sub-menu item Description

Printer Status Report  Prints current product information, cartridge status, and other
product information.

Print Quality Report  Prints a quality test that will help you diagnose minor print issues.

Usage Page  Shows a count of all paper sizes that have passed through the
product; lists whether they were monochrome or color, simplex or
duplex, and reports the page count. This report is useful for
reconciling contractual billing statements.

Network Configuration Page  Prints useful information about the product's wired or wireless
network connection.

Event Log  Prints a list of errors and intermittent failures designed to help you
troubleshoot problems.

PCL Font List  Prints a list of all the PCL fonts that are installed.

PCL6 Font List  Prints a list of all the PCL6 fonts that are installed.

PS Font List  Prints a list of all the PS fonts that are installed
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3 Connect the product

● Connect the product using a USB cable

● Connect the product to a network

● Connect the product to a wireless network (wireless models only)

Connect the product using a USB cable
This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using
a cable that is no longer than 2 m (6.5 ft).

CAUTION: Do not connect the USB cable until the installation software prompts you to connect it.

IMPORTANT: This printer is designed to be used on a level surface. Operating the printer when not
level could result in inaccurate printer messaging about the amount of ink remaining in cartridges.

CD installation
1. Quit all open programs on the computer.

2. Install the software from the CD, and follow the onscreen instructions.

NOTE: If you are installing on a Mac, click the HP Installer icon to install the software.

3. When prompted, select the USB-Connect the printer to the computer using a USB cable
option, and then click the Next button.

NOTE: A dialog displays warning that Web Services (HP ePrint and print Apps) will not be
available with a USB installation. Click the Yes button to proceed with the USB installation, or
click the No button to cancel the USB installation.
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4. When the software prompts you, connect the USB cable to the computer and the product.

5. When the installation is complete, print a page from any program to make sure that the printing
software is correctly installed.

Connect the product to a network

Supported network protocols
To connect a networking-equipped product to a network, you need a network that uses one or more
of the following protocols.

● TCP/IP (IPv4 or IPv6)

NOTE: While this product can be used over IPv6 networks, a product software installation from
the CD is not supported over IPv6 networks.

● LPD Printing

● SLP

● WS-Discovery

● HP Wireless Direct

Install the product on a wired network
Use this procedure to install the product on a wired network.
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Obtain the IP address

1. Connect the ehternet cable to the product and to the network. Turn the product on.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.

3. At the product control panel, press the Setup  button.

4. Touch the Print Reports menu, and then touch the Network Configuration Page menu item to
print the configuration report.

5. Find the IP address on the configuration report.

Printer Status Report

[ [[ [ [ [[ [ [ [

Install the software

1. Quit all programs on the computer.

2. Install the software from the CD.

3. Follow the onscreen instructions.
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4. When prompted, select the Wired Network - Connect the printer to your network using an
Ethernet cable. option, and then click the Next button.

5. From the list of available printers, select the printer that has the correct IP address.

6. When the installation is complete, print a page from any program to make sure that the printing
software is correctly installed.

Configure IP network settings

View or change network settings

Use the embedded Web server to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.

● If you are using IPv4, the IP address contains only digits. It has this format:

xxx.xxx.xxx.xxx
● If you are using IPv6, the IP address is a hexadecimal combination of characters and digits.

It has a format similar to this:

xxxx::xxxx:xxxx:xxxx:xxxx
2. To open the HP Embedded Web Server, type the IP address (IPv4) into the address line of a

Web browser. For IPv6, use the protocol established by the Web browser for entering IPv6
addresses.

3. Click the Networking tab to obtain network information. You can change settings as needed.

Set or change the product password

Use the HP Embedded Web Server to set a password or change an existing password for a product
on a network so unauthorized users cannot change the product settings.

1. Type the product IP address into the address line of a Web browser. Click the Settings tab, click
Security, and then click the Password Settings link.

NOTE: If a password has previously been set, you are prompted to type the password. Type
“admin” for User Name along with the password, and then click the Apply button.

2. Type the new password in the Password box and in the Confirm Password box.

3. At the bottom of the window, click the Apply button to save the password.

Manually configure IPv4 TCP/IP parameters from the control panel

Use the control-panel menus to manually set an IPv4 address, subnet mask, and default gateway.

HP OfficeJet Pro X451

1. Select the Setup  option from the Home screen.

2. Select the Network option.

3. Select the Advanced Setup option.
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4. Select the IPv4 option.

5. Select the Manual option.

6. Select the IP Address option.

7. Use the numeric keypad to enter the IP address, and touch the OK button. Touch the Yes button
to confirm.

8. Use the numeric keypad to enter the subnet mask, and touch the OK button. Touch the Yes
button to confirm.

9. Use the numeric keypad to enter the default gateway, and touch the OK button. Touch the Yes
button to confirm.

HP OfficeJet Pro X551

1. From the control panel, touch the Wireless  button.

2. Touch the Advanced Setup menu, and then touch the IPv4 Settings button.

3. Touch the Manual IP Address button

4. Use the numeric keypad to enter the IP address, and touch the OK button. Touch the Yes button
to confirm.

5. Use the numeric keypad to enter the subnet mask, and touch the OK button. Touch the Yes
button to confirm.

6. Use the numeric keypad to enter the default gateway, and touch the OK button. Touch the Yes
button to confirm.
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Link speed and duplex settings

NOTE: This information applies only to Ethernet networks. It does not apply to wireless networks.

The link speed and communication mode of the print server must match the network hub. For most
situations, leave the product in automatic mode. Incorrect changes to the link speed and duplex
settings might prevent the product from communicating with other network devices. If you need to
make changes, use the product control panel.

NOTE: The setting must match with the network product to which you are connecting (a network
hub, switch, gateway, router, or computer).

NOTE: Making changes to these settings causes the product to turn off and then on. Make changes
only when the product is idle.

1. From the control panel, press (X451 Series) or touch (X551 Series) the Setup  button.

2. Press or touch the Network Setup menu item.

3. Press or touch the Advanced Setup menu item.

4. Press or touch the Link Speed menu.

5. Select one of the following options.

Setting Description

Automatic The print server automatically configures itself for the highest link speed and
communication mode allowed on the network.

10 Half 10 megabytes per second (Mbps), half-duplex operation

10 Full 10 Mbps, full-duplex operation

100 Full 100 Mbps, full-duplex operation

100 Half 100 Mbps, half-duplex operation

6. Press or touch the OK button. The product turns off and then on.

HP ePrint
With HP ePrint , you can print anywhere, anytime, from a mobile phone, laptop, or any other mobile
device. HP ePrint works with any email-capable device. If you can e-mail, you can print to an
HP ePrint-enabled product. For more details, go to www.hpeprintcenter.com.

NOTE: The product must be connected to a network and have Internet access to use HP ePrint.

HP ePrint is disabled as a default setting in the product. Use this procedure to enable it.

1. Type the product IP address into the address line of a Web browser to open the HP Embedded
Web Server.

2. Click the HP Web Services tab.

3. Select the option to enable Web Services.
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Connect the product to a wireless network (wireless
models only)

Before installing the product software, make sure the product is not connected to the network using a
ehternet cable.

If your wireless router does not support Wi-Fi Protected Setup (WPS), obtain the wireless router
network settings from your system administrator, or complete the following tasks:

● Obtain the wireless network name or service set identifier (SSID).

● Determine the security password or encryption key for the wireless network.

Connect the product to a wireless network using the Wireless Setup
Wizard (Officejet Pro X551)

If your wireless router does not support WiFi-Protected Setup (WPS), you can use this method to
install the product on a wireless network.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Network button, and then touch the Wireless Setup Wizard button.

3. The product scans for available wireless networks and returns a list of network names (SSIDs).
Select the SSID for your wireless router from the list if it is available. If the SSID for your wireless
router is not in the list, touch the Enter SSID button. When prompted for the type of network
security, select the option that your wireless router uses. A keypad opens on the control panel
display.

4. If your wireless router uses WPA security, type the passphrase on the keypad.

If your wireless router uses WEP security, type the key on the keypad.

5. Touch the OK button, and wait while the product establishes a connection with the wireless
router. Establishing the wireless connection can take a few minutes.

Connect the product to a wireless network using WPS
1. From the product control panel, press (X451 Series) or touch (X551 Series) the Wireless 

button.

2. Press the Wireless menu button.

3. Press the Wi-Fi Protected Setup button, and then press the Continue button.

4. Use one of these methods to complete the setup:

● Pushbutton: Select the Push Button option and follow the instructions on the control panel.
Establishing the wireless connection can take a few minutes.

● PIN: Select the Generate PIN option and follow the instructions on the control panel. The
product generates a unique PIN, which you must type into the wireless router's setup
screen. Establishing the wireless connection can take a few minutes.
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NOTE: If this method is not successful, try using the Wireless Setup Wizard on the product control
panel or try using the USB cable connection method.

Connect the product to a wireless network using a USB cable (Officejet
Pro X451 only)

If your wireless router does not support WiFi-Protected Setup (WPS), use this method to set up the
product on a wireless network. Using a USB cable to transfer settings makes setting up a wireless
connection easier. After the setup is complete, you can disconnect the USB cable and use the
wireless connection.

1. Insert the software CD into the computer CD tray.

2. Follow the on-screen instructions. When prompted, select the Wireless- Connect the printer to
your wireless network and internet. option. Connect the USB cable to the product when
prompted.

CAUTION: Do not connect the USB cable until the installation program prompts you.

3. When the installation is complete, print a configuration page to make sure that the product has
an SSID name.

4. When installation is complete, disconnect the USB cable.

Install the software for a wireless product currently on the network
If the product already has an IP address on a wireless network and you want to install product
software on a computer, complete the following steps.

1. From the product control panel, print a configuration page to obtain the product IP address.

2. Install the software from the CD.

3. Follow the on-screen instructions.

4. When prompted, select the Wireless- Connect the printer to your wireless network and
internet. option, and then click the Next button.

5. From the list of available printers, select the printer that has the correct IP address.

Manually connect the product to a wireless network
During the first 120 minutes of product setup, or after resetting the product's network defaults (and
without a network cable attached to the product), the product's wireless radio will broadcast a
wireless setup network for the product.

The name of this network is “HP-Setup-xx-[product name]”.
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NOTE: The “xx” in the network is name is the last two characters of the product's MAC address.
The product name will be either HP Officejet Pro X451 MFP Series or HP Officejet Pro X551 MFP
Series.

1. From a wireless enabled product, connect to the setup network for the device.

2. Open a web browser while connected to this setup network, and open the HP Embedded Web
Server (HP EWS) using the following IP address:

● 192.168.223.1

3. Find the Wireless Setup Wizard in the product's EWS and follow the on screen instructions to
manually connect the product.

NOTE: The product uses Automatic DHCP by default.
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4 Use the product with Windows

● Supported operating systems and printer drivers for Windows

● Select the correct printer driver for Windows

● Change print job settings for Windows

● Remove the printer driver from Windows

● Supported utilities for Windows

Supported operating systems and printer drivers for
Windows

The product supports the following Windows operating systems:

Recommended software installation

● Windows XP (32-bit, Service Pack 2 or higher)

● Windows Vista (32-bit and 64-bit)

● Windows 7 (32-bit and 64-bit)

● Windows 8 (32-bit and 64-bit)

Print drivers only

● Windows 2003 Server (32-bit, Service Pack 3)

● Windows 2008 Server

● Windows 2008 Server R2

NOTE: Windows Server install support is available through
the Enterprise (command line) install method only.

The product supports the following Windows printer drivers:

● HP PCL 6 (this is the default printer driver and is included on the CD)

● HP Universal Print Driver for Windows Postscript

● HP Universal Print Driver for PCL 5

● HP Universal Print Driver for PCL 6

The printer drivers include online Help that has instructions for common printing tasks and also
describes the buttons, checkboxes, and drop-down lists that are in the printer driver.

NOTE: For downloads of, and more information about, the HP UPD Postscript, PCL 5, and PCL 6
drivers, see www.hp.com/go/upd.

Select the correct printer driver for Windows
Printer drivers provide access to the product features and allow the computer to communicate with
the product (using a printer language).

ENWW Supported operating systems and printer drivers for Windows 39

http://www.hp.com/go/upd


HP PCL 6 driver (This print driver is
provided on the in-box CD and is also
available from http://www.hp.com/go/
support.)

● Provided as the default driver. This driver is automatically installed unless
you select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP UPD PS driver (This print driver is
available for download from
www.hp.com/go/upd)

● Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for
postscript flash font support

HP UPD PCL 5 (This print driver is
available for download from
www.hp.com/go/upd)

● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP Officejet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single
driver for use with multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows
computer

HP UPD PCL 6 (This print driver is
available for download from
www.hp.com/go/upd)

● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for
most users

● Developed to align with Windows Graphic Device Interface (GDI) for best
speed in Windows environments

● May not be fully compatible with third-party and custom solutions based on
PCL5
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HP Universal Print Driver (UPD)
The HP Universal Print Driver (UPD) for Windows is a single driver that gives you instant access to
virtually any HP Officejet product, from any location, without downloading separate drivers. It is built
on proven HP print driver technology and has been tested thoroughly and used with many software
programs. It is a powerful solution that performs consistently over time.

The HP UPD communicates directly with each HP product, gathers configuration information, and
then customizes the user interface to show the product’s unique, available features. It automatically
enables features that are available for the product, such as two-sided printing, so you do not need to
enable them manually.

For more information, go to www.hp.com/go/upd.

UPD installation modes

Traditional mode ● Use this mode if you are installing the driver for a single computer. See
www.hp.com/go/upd.

● When installed in Traditional mode, UPD operates like a discrete printer
driver. It operates with a specific product.

● If you use this mode, you must install UPD separately for each computer and
for each product.

Dynamic mode ● To use this mode, download UPD from the Internet. See www.hp.com/go/
upd.

● Dynamic mode allows you to use a single driver installation, so you can
discover and print to HP products in any location.

● Use this mode if you are installing UPD for a workgroup or to have
convenient access to a fleet of printers for individual users.

Change print job settings for Windows

Priority for print settings
Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software
program. In managed environments, administrators may enforce printing policies and restrictions.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here override settings
changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and usually do not override changes made in the Page Setup dialog box.

● Printer Properties dialog box (printer driver): Click Properties in the Print dialog box to open
the printer driver. Settings changed in the Printer Properties dialog box usually do not override
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settings anywhere else in the printing software, but will be applied if no conflicting command is
sent with a print job. You can change most of the print settings here.

● Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower
priority than changes made anywhere else.

Change the settings for all print jobs until the software program is closed
1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

The steps can vary; this procedure is most common.

Change the default settings for all print jobs
1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start

menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start
menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and
Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Printing Preferences.

Change the product configuration settings
1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start

menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start
menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and
Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Device Settings tab.

42 Chapter 4   Use the product with Windows ENWW



Remove the printer driver from Windows
Windows XP

1. Click Start, Control Panel, and then Add or Remove Programs.

2. Find and select the product from the list.

3. Click the Change/Remove button to remove the software.

Windows Vista

1. Click Start, Control Panel, and then Programs and Features.

2. Find and select the product from the list.

3. Select the Uninstall/Change option.

Windows 7

1. Click Start, Control Panel, and then under the Programs heading, click Uninstall a program.

2. Find and select the product from the list.

3. Select the Uninstall option.

Supported utilities for Windows
● HP Web Jetadmin

● HP Embedded Web Server

● HP ePrint

● HP Wireless Direct
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5 Use the product with Mac

● Supported operating systems and printer drivers for Mac

● Software for Mac computers

● Priority for print settings for Mac

● Change printer-driver settings for Mac

● Remove the printer driver from Mac operating systems

● Supported utilities for Mac

● Solve problems with Mac

Supported operating systems and printer drivers for Mac
The product supports the following Mac operating systems:

● Mac OS X 10.6 and later

NOTE: See www.hp.com/support for the latest drivers for Mac.

NOTE: For Mac OS X 10.6 and later, Intel Core Processor Macs are supported.

The HP Officejet software installer provides PostScript® Printer Description (PPD) files, Printer Dialog
Extensions (PDEs), and the HP Utility for use with Mac OS X computers. The HP printer PPD and
PDE files, in combination with the built-in Apple PostScript printer drivers, provide full printing
functionality and access to specific HP printer features.

Software for Mac computers

HP Utility for Mac
Use the HP Utility to set up product features that are not available in the printer driver.

You can use the HP Utility when the product uses a universal serial bus (USB) cable or is connected
to a TCP/IP-based network.

Open the HP Utility

Use any of the following methods to open the HP Utility:

● From the dock, click HP Utility.

● From Applications, open the Hewlett-Packard folder, and then click HP Utility.

● Click the Utility tab of the Options and Supplies panel from Print and Fax.
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HP Utility features

Use the HP Utility software to perform the following tasks:

● Obtain information about supplies status.

● Obtain information about the product, such as the firmware version and the serial number.

● Print a configuration page.

● For products connected to an IP-based network, obtain network information and open the
HP Embedded Web Server.

● Configure the paper type and size for the tray.

● Transfer files and fonts from the computer to the product.

● Update the product firmware.

Priority for print settings for Mac
Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software
program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here might override
settings changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and do not override changes made in the Page Setup dialog box.

● Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower
priority than changes made anywhere else.

Change printer-driver settings for Mac

Change the settings for all print jobs until the software program is closed
1. On the File menu, click the Print button.

2. Change the settings that you want on the various menus.
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Change the default settings for all print jobs
1. On the File menu, click the Print button.

2. Change the settings that you want on the various menus.

3. On the Presets menu, click the Save As... option and type a name for the preset.

These settings are saved in the Presets menu. To use the new settings, you must select the saved
preset option every time you open a program and print.

Change the product configuration settings
1. From the Apple menu , click the System Preferences menu and then click the Print & Scan

icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Driver tab.

5. Configure the installed options.
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Remove the printer driver from Mac operating systems
You must have administrator rights to remove the software.

1. Open System Preferences.

2. Select Print & Scan.

3. Highlight the product.

4. Click the minus (-) symbol to delete the print queue.

Supported utilities for Mac

HP Embedded Web Server
The product is equipped with the HP Embedded Web server, which provides access to information
about product and network activities. Access the HP Embedded Web Server from the HP Utility.
Open the Printer Settings menu, and then select the Additional Settings option.

You can also access the HP Embedded Web Server from the Safari Web browser:

1. Select the page icon in the left side of the Safari toolbar.

2. Click the Bonjour logo.

3. In the list of printers, double-click this product. The HP Embedded Web Server opens.

To access the HP Embedded Web Server from any web browser, type the product's IP address in the
browser's address field.

The HP Embedded Web Server can also be accessed through the System Preferences menu. Click
System Preferences, click Print and Scan, select your product name, click Options and Supplies,
click General, and then click Show Printer Webpage.

Solve problems with Mac
For information about solving problems with a Mac, see Solve product software problems with Mac
on page 150.
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6 Paper and print media

● Understand paper use

● Change the printer driver to match the paper type and size in Windows

● Supported paper sizes

● Supported paper types and tray capacity

● Load paper trays

● Configure trays

Understand paper use
HP Officejet inks for business are specifically developed for use with HP printheads. Unique ink
formulations help extend the life of the printheads and enhance reliability. When used with ColorLok®
paper, these inks provide laser-like color output that dries quickly and is ready for distribution.

This product supports a variety of paper and other print media. Paper or print media that does not
meet the following guidelines might cause poor print quality, increased jams, and premature wear on
the product.

It is possible for paper to meet all of these guidelines and still not produce satisfactory results. This
might be the result of improper handling, unacceptable temperature and/or humidity levels, or other
variables over which Hewlett-Packard has no control.

CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.

● For best results, use only HP-brand paper and print media designed for inkjet printers or
multiuse.

● Use paper or print media made for inkjet printers.

● Hewlett-Packard Company cannot recommend the use of other brands of media because HP
cannot control their quality.

NOTE: Based on HP internal testing using a range of plain papers, HP highly recommends using
papers with the ColorLok® logo for this product. For details, go to www.hp.com/go/printpermanence.

Use the following guidelines to obtain satisfactory results when using special paper or print media.
Set the paper type and size in the printer driver to obtain the best results.
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Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam
extends all the way to the corner
of the envelope.

● Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.

● Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

Labels ● Use only labels that have no
exposed backing between them.

● Use labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have
wrinkles or bubbles, or are
damaged.

● Do not print partial sheets of
labels.

Letterhead or preprinted forms ● Use only letterhead or forms
approved for use in inkjet printers.

● Do not use raised or metallic
letterhead.

Heavy paper ● Use only heavy paper that is
approved for use in inkjet printers
and meets the weight
specifications for this product.

● Do not use paper that is heavier
than the recommended media
specification for this product
unless it is HP paper that has
been approved for use in this
product.

Glossy or coated paper ● Use only glossy or coated paper
that is approved for use in inkjet
printers.

● Do not use glossy or coated paper
designed for use in laser products.

Change the printer driver to match the paper type and
size in Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

5. Select a paper type from the Paper type drop-down list.

6. Click the OK button.

Supported paper sizes
NOTE: To obtain best print results, select the appropriate paper size and type in your print driver
before printing.
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Table 6-1  Supported paper and print media sizes

Size Dimensions Tray 1 Tray 2 Tray 3 Automatic duplex
printing

Letter 216 x 279 mm (8.5 x 11 inches)

Oficio 8.5 x 13 (8.5 x 13 inches)  

Oficio
216x340 mm

216 x 340 mm  

Legal 216 x 356 mm (8.5 x 14 inches)  

A4 210 x 297 mm (8.3 x 11.7 inches)

Executive 184 x 267 mm (7.25 x 10.5
inches)

Statement 140 by 216 mm (5.5 x 8.5 inches)

A5 148 x 210 mm (5.8 x 8.3 inches)  

A6 105 x 148.5 mm (4.13 x 5.83
inches)

   

B5 (JIS) 182 x 257 mm (7.17 x 10.12
inches)

B6 (JIS) 128x182mm (5 x 7 inches)    

16k 184 x 260 mm (7.24 x 10.23
inches)

195 x 270 mm (7.68 x 10.62
inches)

197 x 273 mm (7.75 x 10.75
inches)

 

Custom Minimum: (3 x 5 inches)

Maximum: (8.5 to 14 inches)

Width: (3 to 8.5
inches)

Length: (5 to 14
inches)

Width: (4 to 8.5
inches)

Length: (8.27 to
11.7 inches)

Width: (4 to 8.5
inches)

Length: (8.27 to
14 inches)

 

Table 6-2  Supported envelopes

Size Dimensions Tray 1 Tray 2 Tray 3 Automatic duplex
printing

Envelope
#10

105 x 241 mm (4.13 x 9.49 inches)   

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)   

Envelope C5 162 x 229 mm (6.4 x 9 inches)   

Envelope B5 176 x 250 mm (6.7 x 9.8 inches)   
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Table 6-2  Supported envelopes (continued)

Size Dimensions Tray 1 Tray 2 Tray 3 Automatic duplex
printing

Envelope C6 114 x 162 mm (4.5 x 6.4 inches)    

Envelope
Monarch 98 x 191 mm (3.9 x 7.5 inches)

   

Japanese
Envelope
Chou #3

120 x 235 mm (4.7 x 9.3 inches)   

Japanese
Envelope
Chou #4

90 x 205 mm (3.5 x 8.1 inches)    

Table 6-3  Supported cards

Size Dimensions Tray 1 Tray 2 Tray 3 Automatic duplex
printing

3x5 (76.2 x 127 mm) (3 x 5 inches)    

4x6 (102 x 152 mm) (4 x 6 inches)    

5x8 (127 x 203 mm) (5 x 8 inches)    

A6 (105 x 148.5 mm) (4.13 x 5.83
inches)

   

Japanese
Postcard

(100 x 148 mm) (3.9 x 5.8 inches)    

Double
Japan
Postcard
Rotated

(148 x 200 mm) (5.8 x 7.9 inches)    

Table 6-4  Supported photo media

Size Dimensions Tray 1 Tray 2 Tray 3 Automatic duplex
printing

4x6 (102 x 152 mm) (4 x 6 inches)    

10x15cm (100 x 150 mm) (3.9 x 5.9 inches)    

L (89 x 127 mm) (3.5 x 5 inches)    

5x7 Photo
Media (5 x 7
in no-tabs)

(127 x 178 mm) (5 x 7 inches)    

Photo Media
(Letter &A4)
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Table 6-4  Supported photo media (continued)

Size Dimensions Tray 1 Tray 2 Tray 3 Automatic duplex
printing

Japanese
Postcard

(100 x 148 mm) (3.9 x 5.8 inches)    

Custom Minimum: (3 to 5 inches)

Maximum: (8.5 to 14 inches)

Width: (3 to 8.5
inches)

Length: (5 to 14
inches)

Width: (4 to 8.5
inches)

Length: (8.27 to
11.7 inches)

Width: (4 to 8.5
inches)

Length: (8.27 to
14 inches)

 

Table 6-5  Other supported media

Size Dimensions Tray 1 Tray 2 Tray 3 Automatic duplex printing

Labels
(Letter and
A4)

  

Supported paper types and tray capacity
Table 6-6  Tray 1 (multi-purpose) on left side of the product

Paper type Weight Capacity1 Paper orientation

Every day:

● Unspecified and Plain

● HP EcoSMART Lite

● Light 60-74g

● Intermediate 85-95g

● Mid-Weight 96-110g

● Heavy 111-130g

● HP Premium Presentation
Matte 120g

● Extra Heavy 131-175g

60 to 175 g/m2 (16 to 47 lb) Up to 50 sheets Side to be printed on face-down,
with the top edge at the front of
the tray

● HP Brochure Matte 180g

● HP Brochure Glossy 180g

● Cardstock 176-220g

● HP Cover Matte 200g

● HP Advanced Photo
Papers

Up to 220 g/m2 (58 lb) 1 Up to 25 sheets Side to be printed on face-up,
with the top edge at the back of
the tray
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Table 6-6  Tray 1 (multi-purpose) on left side of the product (continued)

Paper type Weight Capacity1 Paper orientation

● Envelope

● Heavy Envelope

● Labels

 Up to 7 envelopes or labels Side to be printed on face-up,
with the top edge toward the
product

1 Capacity can vary depending on paper weight and thickness, and environmental conditions.

Table 6-7  Tray 2 (main tray) and Tray 3 (accessory tray)

Paper type Weight Capacity1 Paper orientation

● Unspecified and Plain

● HP EcoSMART Lite

● Light 60-74g

● Intermediate 85-95g

● Mid-Weight 96-110g

● Heavy 111-130g

● HP Premium Presentation
Matte 120g

● Extra Heavy 131-175g

60 to 175 g/m2 (16 to 47 lb) Up to 500 sheets Side to be printed on face-up,
with the top edge at the front of
the tray

● HP Brochure Matte 180g

● HP Brochure Glossy 180g

● Cardstock 176-220g

● HP Cover Matte 200g

● HP Advanced Photo
Papers

Up to 220 g/m2 (58 lb)1 Up to 100 sheets Side to be printed on face-up,
with the top edge at the back of
the tray

● Envelope

● Heavy Envelope

● Labels

 Up to 30 envelopes or labels

NOTE: Tray 3 does not
support envelope printing.

Side to be printed on face-up,
with the top edge toward the
product

1 Capacity can vary depending on paper weight and thickness, and environmental conditions.
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Load paper trays

Load Tray 1 (multi-purpose tray on left side of the product)

1. Open Tray 1.  

2. Pull out the extension tray.  

3. Extend the paper guides fullyand then load
the paper stack into Tray 1. Adjust the paper
guides to the size of the paper.

NOTE: Place the paper into Tray 1 with the
side to be printed on face-down and top of
page toward the front of the tray.
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Load Tray 2 or optional Tray 3

1. Pull the tray out of the product.  

2. Slide open the paper length and width guides.  

3. Place the paper in the tray and make sure
that it is flat at all four corners. Slide the side
paper width guides so that they align with the
paper-size marking in the bottom of the tray.
Slide the front paper length guide so that it
pushes the stack of paper against the back of
the tray.

NOTE: Place the paper into the tray with the
side to be printed on face-up.
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4. Push down on the paper to make sure that
the paper stack is below the paper limit tabs
on the side of the tray.

 

5. Slide the tray into the product.  

Configure trays
By default, the product pulls paper from Tray 2. If Tray 2 is empty, the product pulls paper from Tray
1, or Tray 3 if it is installed. Configuring a tray on this product changes the speed settings to obtain
the best print quality for the type of paper that you are using. If you are using special paper for all or
most print jobs on the product, change this default tray setting on the product.

The following table lists possible ways you can use the tray settings to meet your printing needs.

Paper use Configure the product Print

Load Tray 1 and one other tray with the
same paper, and have the product pick
paper from one tray if the other one is
empty.

Load paper in Tray 1. No configuration
is needed, if the default settings for type
and size have not been changed.

From the software program, print the
job.
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Paper use Configure the product Print

Occasionally use special paper, such
as heavy paper or letterhead, from a
tray that usually contains plain paper.

Load special paper in Tray 1. From the software program print dialog,
choose the paper type that matches the
special paper loaded in the tray before
sending the print job. Select Tray 1 as
the Paper Source from the Paper/
Quality tab (Windows) or Paper Feed
menu (Mac).

Frequently use special paper, such as
heavy paper or letterhead, from one
tray.

Load special paper in Tray 1, and
configure the tray for the paper type.

From the software program print dialog,
choose the paper type that matches the
special paper loaded in the tray before
sending the print job. Select Tray 1 as
the Paper Source from the Paper/
Quality tab (Windows) or Paper Feed
menu (Mac).

Configure trays

1. Make sure the product is turned on.

2. Perform one of the following tasks:

● Control panel: Press (X451 Series) or touch (X551 Series) the Setup  button, press or
touch Paper Handling, and then press or touch Paper Selection. Select the tray that you
want to configure.

● Embedded Web server: Click the Settings tab, and then click Paper Settings in the left
panel. Select a Default Media Size and a Default Media Type for each tray.

3. Press OK or click Apply.
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7 Ink cartridges

The information contained herein is subject to change without notice. For the latest User Guide
information go to www.hp.com/support/ojpx451 or www.hp.com/support/ojpx551.

● Ink cartridge information

● Supplies views

● Manage ink cartridges

● Replacement instructions

● Solve issues with supplies

Ink cartridge information

Color Cartridge number Part number

Standard-capacity replacement black
ink cartridge

HP 970 CN621A

High-capacity replacement black ink
cartridge

HP 970XL CN625A

Standard-capacity replacement cyan
ink cartridge

HP 971 CN622A

High-capacity replacement cyan ink
cartridge

HP 971XL CN626A

Standard-capacity replacement yellow
ink cartridge

HP 971 CN624A

High-capacity replacement yellow ink
cartridge

HP 971XL CN628A

Standard-capacity replacement
magenta ink cartridge

HP 971 CN623A

High-capacity replacement magenta ink
cartridge

HP 971XL CN627A

Accessibility: The ink cartridge can be installed and removed by using one hand.

Environmental features: Recycle ink cartridges by using the HP Planet Partners return and
recycling program.

For more information about supplies, go to www.hp.com/go/learnaboutsupplies.
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Supplies views

Ink cartridge view

1

1 Metal connector and ink nozzle. Do not touch. Fingerprints may cause supply error messages. Dust may also cause
supply error messages; do not leave ink cartridges outside the product for prolonged periods of time.

Manage ink cartridges
Correctly using, storing, and monitoring the ink cartridge can help ensure high-quality print output.

Change settings for ink cartridges

Print when an ink cartridge is at estimated end of life

Supply-related notifications are communicated on the product control panel.

● A <Supply> Low message—where <Supply> is the cartridge—appears when an ink cartridge is
nearing the estimated end of its useful life and a replacement cartridge should be obtained for
use when needed.

● A <Supply> Very Low message appears when the ink cartridge is near its estimated end of
useful life.

● <Supply> Out of Ink message appears when the ink cartridge is empty.
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Modify the Low Ink Warning Level settings from the control panel

You can enable or disable the default settings at any time, and you do not have to re-enable them
when you install a new ink cartridge.

1. From the Home screen on the control panel, press (X451 Series) or touch (X551 Series) the
Setup  button.

2. Press or touch the Device Setup menu.

3. Press or touch the Ink Low Warning Level menu item.

4. Select from the following options for each supply:

● Select Automatic to keep the default low ink warning.

● Select a fill percentage to choose what ink level prompts a low ink level warning

Print with General Office mode

General Office print mode uses less ink, which might extend the life of the cartridge.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select General Office from the Print Quality drop-down box.

Store and recycle supplies

Recycle supplies

Go to hp.com/recycle for full information on recycling, and to order postage-paid labels, envelopes,
and boxes for recycling.

Ink cartridge storage

Do not remove the ink cartridge from its package until you are ready to use it.

HP policy on non-HP ink cartridges

Hewlett-Packard Company cannot recommend the use of non-HP ink cartridges, either new or
remanufactured.

NOTE: Any damage caused by a non-HP print cartridge is not covered under the HP warranty and
service agreements.

HP anticounterfeit website
Go to www.hp.com/go/anticounterfeit when you install an HP print cartridge and the control-panel
message says the cartridge is used or counterfeit. HP will help to take steps to resolve the problem.
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Your ink cartridge might not be a genuine HP ink cartridge if you notice the following:

● The supplies status page indicates that a used or counterfeit supply is installed.

● You are experiencing a high number of problems with the ink cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from
HP packaging).

Replacement instructions

Replace the ink cartridges
The product uses four colors and has a different ink cartridge for each color: yellow (Y), cyan (C),
magenta (M), and black (K).

1. Open the ink cartridge door.  

2. Push the old ink cartridge inward to unlock it.  
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3. Grasp the edge of the old ink cartridge and
then pull the cartridge straight out to remove
it.

 

4. Remove the new ink cartridge from the
packaging.

 

5. Do not touch the metal connector of the ink
cartridge. Fingerprints on the connector can
cause print-quality problems.
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6. Insert the new ink cartridge into the product.  

7. Close the ink cartridge door.  

8. Place the old ink cartridge in the box and refer
to HP's recycling instructions at
http://wwww.hp.com/recycle.

 

Solve issues with supplies

Check the ink cartridges
If you are experiencing print quality problems, see Improve print quality on page 132.

NOTE: If you are using a General Office print setting, the printing might appear light.

If you determine that you need to replace an ink cartridge, look on the cartridge or print the Supplies
Status Page to find the part number for the correct genuine HP ink cartridge.

Refilled or remanufactured ink cartridges

Hewlett-Packard Company cannot recommend the use of non-HP supplies, either new or
remanufactured. Because they are not HP products, HP cannot influence their design or control their
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quality. If you are using a refilled or remanufactured ink cartridge and are not satisfied with the print
quality, replace the cartridge with a genuine HP cartridge.

NOTE: If you replace a non-HP ink cartridge with a genuine HP ink cartridge, the printhead may still
contain non-HP ink until the printhead is depleted of that ink and is supplied with ink from the newly
installed, genuine HP ink cartridge.

Interpret the Print Quality Report

1. On the product control panel, press (X451 Series) or touch (X551 Series) the Setup  button.

2. Press or touch the Print Reports menu item.

3. Press or touch the Print Quality Report item to print it.

4. Follow the instructions on the page that prints.

This page contains four bands of color, which are divided into the groups as indicated in the following
illustration. By examining each group, you can isolate the problem to a particular ink color.

3

4

1

2

Section Ink cartridge

1 Black

2 Cyan
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Section Ink cartridge

3 Magenta

4 Yellow

● If dots or streaks appear in one or more groups, clean the printhead. If this does not solve the
problem, contact HP.

● If streaks appear in multiple color bands, see if the problem still persists by performing an
additional print head cleaning, and then contact HP. A component other than the ink cartridge is
probably causing the problem.
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Interpret control panel messages for supplies

Non-HP ink cartridges installed

Description

No action necessary, this is a notification only.

Recommended action

Use SETUP Cartridges

Description

The SETUP cartridges have been removed before the product has completed initialization.

Recommended action

Use the SETUP cartridges that came with your product for product initialization.

Do not use SETUP cartridges

Description

SETUP cartridges cannot be used after the device has been initialized.

Recommended action

Remove and install non-SETUP cartridges.

<Color>Cartridge Low

Description

The ink cartridge is nearing the end of its useful life.

Recommended action

Printing can continue, but consider having a replacement supply on hand.

<Color>Cartridge Very Low

Description

The ink cartridge is near the end of its useful life.

Recommended action

Have a replacement ink cartridge on hand.

Counterfeit or used <color> cartridge installed

Description

The original HP ink in this cartridge has been depleted.
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Recommended action

Click OK to continue printing or replace with genuine HP cartridge.

Genuine HP supply installed

Description

A genuine HP supply was installed.

Recommended action

No action necessary.

Incompatible <color>

Description

You have installed an ink cartridge that is intended for use in a different HP product model. The
product will NOT function with this print cartridge installed.

Recommended action

Install the correct ink cartridge for this product.

Install [color] cartridge

Description

This message can appear during the initial set up of the product and may also appear after the initial
set up of the product has been completed.

If this message appears during initial setup, it means one of the color cartridges is not installed with
the door closed. The product will not print if a cartridge is missing.

If this message appears after the initial set up of the product, it means that the cartridge is missing or
is installed but damaged.

Recommended action

Install or replace the indicated color cartridge.

Out of Ink <Color>

Description

The ink cartridge is at the end of its useful life, and the product will no longer print.

Recommended action

Replace the ink cartridge.

Used [color] installed, to accept press OK

Description

A used, but still genuine, HP color ink cartridge has been installed or moved.
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Recommended action

You have a used, but still genuine, HP cartridge installed. No action required.
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8 Print

● Print tasks (Windows)

● Print tasks (Mac)

● Additional print tasks (Windows)

● Additional print tasks (Mac OS X)

● Use HP ePrint

● Use the HP ePrint Mobile Driver

● AirPrint

● Connect the printer with HP Wireless Direct

● Plug and Print USB Drive printing

Print tasks (Windows)
The methods to open the print dialog from software programs can vary. The procedures that follow
include a typical method. Some software programs do not have a File menu. See the documentation
for your software program to learn how to open the print dialog.

Open the printer driver with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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Get help for any printing option with Windows

1. Click the Help button to open the online Help.  
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Change the number of print copies with Windows
1. On the File menu in the software program, click Print.

2. Select the product, and then select the number of copies.

Save custom print settings for reuse with Windows

Use a printing shortcut with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Printing Shortcuts tab.  

4. Select one of the shortcuts, and then click the
OK button.

NOTE: When you select a shortcut, the
corresponding settings change on the other
tabs in the printer driver.

 

Create printing shortcuts

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Printing Shortcuts tab.  

4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before
adjusting any of the settings on the right side
of the screen. If you adjust the settings and
then select a shortcut, all your adjustments
are lost.
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5. Select the print options for the new shortcut.  

6. Click the Save As button.  

7. Type a name for the shortcut, and click the
OK button.

 

Improve print quality with Windows

Select the page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.
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3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

Select a custom page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Custom button.

5. Type a name for the custom size and specify the dimensions.

● The width is the short edge of the paper.

● The length is the long edge of the paper.

NOTE: Always load paper into the trays short edge first.

6. Click the OK button, and then click the OK button on the Paper/Quality tab. The custom page
size will appear in the list of paper sizes the next time you open the printer driver.

Select the paper type with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper, and then click the paper
type that you are using.

Select the paper tray with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a tray from the Paper source drop-down list.

Print on both sides (duplex) with Windows

Automatically print on both sides with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. Select the Print on both sides check box.
Click the OK button to print the job.
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Print multiple pages per sheet with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the number of pages per sheet from
the Pages per sheet drop-down list.

 

5. Select the correct Print page borders, Page
order, and Orientation options.

 

Select page orientation with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Finishing tab.  

4. In the Orientation area, select the Portrait or
Landscape option.

To print the page image upside down, select
the Rotate by 180 degrees option.

 

Set Advanced color options with Windows
1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. Click the HP EasyColor check box to clear it.

5. In the Color Options area, click the Ink Settings button.

6. Use the sliders to adjust the settings, and then click OK.

Print tasks (Mac)

Create and use printing presets with Mac
Use printing presets to save the current printer driver settings for reuse.
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Create a printing preset

1. On the File menu, click the Print option.

2. Select the product from the printer list.

3. Select the print settings that you want to save for reuse.

4. In the Presets menu, click the Save As... option, and type a name for the preset.

5. Click the OK button.

Use printing presets

1. On the File menu, click the Print option.

2. Select the product from the printer list.

3. In the Presets menu, select the printing preset.

NOTE: To use printer-driver default settings, select the standard or Default Settings option.

Print a cover page with Mac
1. On the File menu, click the Print option.

2. Select the product from the printer list.

3. Open the Cover Page menu, and then select where to print the cover page. Click either the
Before Document button or the After Document button.

4. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the standard option from the Cover Page Type
menu.

Print multiple pages on one sheet of paper with Mac

1. On the File menu, click the Print option.

2. Select the product from the Printer list.

3. Open the Layout menu.
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4. From the Pages per Sheet menu, select the number of pages that you want to print on each
sheet (1, 2, 4, 6, 9, or 16).

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

Print on both sides of the page (duplex printing) with Mac

Use automatic duplex printing

1. Insert enough paper into one of the trays to accommodate the print job.

2. On the File menu, click the Print option.

3. Open the Layout menu.

4. From the Two-Sided menu, select a binding option. This sets the default binding; subsequent
duplex jobs can be printed by simply checking the Two-Sided checkbox next to the Copies
field.

Set the color options with Mac
If you are using the HP Postscript printer driver for Mac, HP EasyColor technology scans all
documents and automatically adjusts all photographic images with the same improved photographic
results.

In the following example, the images on the left were created without using the HP EasyColor option.
The images on the right show the enhancements that result from using the HP EasyColor option.

The HP EasyColor option is enabled by default in the HP Mac Postscript printer driver, so you do not
need to make manual color adjustments. To disable the option so you can manually adjust the color
settings, use the following procedure.

1. On the File menu, click the Print option.

2. Select the product from the Printers list.

3. Open the Color Options menu, and then click the HP EasyColor check box to clear it.

4. Adjust the RGB Color Settings by selecting a setting from the RGB Color drop-down menu.
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Additional print tasks (Windows)

Cancel a print job

Cancel a print job with Windows

1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product
control panel.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If
more than one process is running, pressing the Cancel  button clears the process that
currently appears on the product control panel.

NOTE: On HP Officejet Pro X451 MFP Series products, print jobs can also be canceled from
the Job Status menu.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Windows print queue: If a print job is waiting in a print queue (computer memory) or print
spooler, delete the job there.

◦ Windows XP, Server 2003, or Server 2008: Click Start, click Settings, and then click
Printers and Faxes. Double-click the product icon to open the window, right-click the
print job that you want to cancel, and then click Cancel.

◦ Windows Vista: Click Start, click Control Panel, and then, under Hardware and
Sound, click Printer. Double-click the product icon to open the window, right-click the
print job that you want to cancel, and then click Cancel.

◦ Windows 7: Click Start, and then click Devices and Printers. Double-click the
product icon to open the window, right-click the print job that you want to cancel, and
then click Cancel.

Print colored text as black (grayscale) with Windows
1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Advanced tab.

4. Expand the Document Options section.

5. Expand the Printer Features section.

6. In the Print All Text as Black drop-down list, select the Enabled option.

Print on special paper or labels with Windows

1. On the File menu in the software program,
click Print.

 

84 Chapter 8   Print ENWW



2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  

4. From the Paper type drop-down list, click the
More... option.
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5. Expand the list of Type is: options.  

6. Expand the category of paper types that best
describes your paper.

NOTE: Labels are in the list of Other
options.

 

7. Select the option for the type of paper you are
using, and click the OK button.

 

Print the first or last page on different paper with Windows

1. On the File menu in the software program,
click Print.

 

86 Chapter 8   Print ENWW



2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  

4. In the Special pages area, click the Print
pages on different paper option, and then
click the Settings button.
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5. In the Pages in document area, select either
the First or Last option.

 

6. Select the correct options from the Paper
source and Paper type drop-down lists. Click
the Add button.
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7. If you are printing both the first and last pages
on different paper, repeat steps 5 and 6,
selecting the options for the other page.

 

8. Click the OK button.  

Scale a document to fit page size with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

ENWW Additional print tasks (Windows) 89



3. Click the Effects tab.  

4. Select the Print document on option, and
then select a size from the drop-down list.

 

Add a watermark to a document with Windows
1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.

Or, to add a new watermark to the list, click the Edit button. Specify the settings for the
watermark, and then click the OK button.

5. To print the watermark on the first page only, select the First page only check box. Otherwise,
the watermark is printed on each page.
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Create a booklet with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the Print on both sides check box.  

5. In the Booklet layout drop-down list, click the
Left binding or Right binding option. The
Pages per sheet option automatically
changes to 2 pages per sheet.

 

Additional print tasks (Mac OS X)

Cancel a print job with Mac
1. If the print job is currently printing, cancel it by touching the Printing <filename> display near the

bottom of the product control panel, and then touch the Cancel  that becomes available on the
right-side of the control panel.

NOTE: Cancelling a job clears the job that the product is currently processing. If more than one
process is running, repeat step one to cancel the other jobs.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Mac print queue: Open the print queue by double-clicking the product icon in the dock.
Highlight the print job, and then click Delete.
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Change the paper size and type with Mac
1. On the File menu in the software program, click the Print option.

2. Select a size from the Paper Size drop-down list.

3. Open the Paper/Quality panel.

4. Select a type from the Media Type drop-down list.

5. Click the Print button.

Resize documents or print on a custom paper size with Mac

Mac OS X 10.6 and later

Use one of these methods.

1. On the File menu, click the Print option.

2. Select the product, and then select the correct settings for the Paper Size
and Orientation options.

1. On the File menu, click the Print option.

2. Open the Paper Handling menu.

3. In the Destination Paper Size area, click the Scale to fit paper size box,
and then select the size from the drop-down list.

Use watermarks with Mac
1. On the File menu, click the Print option.

2. Open the Watermarks menu.

3. Check the Watermark box to print a semi-transparent message.

4. From the Watermarks menu, select whether to print the watermark on all pages or on the first
page only.

5. From the Text menu, select one of the standard messages, or select the Custom option and
type a new message in the box.

6. Select options for the remaining settings.

Use HP ePrint
Use HP ePrint to print documents by sending them as an e-mail attachment to the product's e-mail
address from any e-mail enabled device.
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NOTE: The product must be connected to a wired or wireless network and have Internet access to
use HP ePrint.

1. To use HP ePrint, you must first enable HP Web Services.

a. From the Home screen on the product control panel, press (X451 Series) or touch (X551
Series) the Web Services  button.

b. Press or touch the Enable Web Services button.

2. From the HP Web Services menu, touch the Display E-Mail Address button to display the
product's e-mail address on the control panel.

3. Use the HP ePrint Center Web site to define security settings and to configure default print
settings for all HP ePrint jobs sent to this product.

a. Go to www.hpeprintcenter.com.

b. Click Sign In, and enter your HP ePrintCenter credentials or sign up for a new account.

c. Select your product from the list, or click + Add printer to add it. To add the product, you
need the printer code, which is the segment of the product e-mail address that is before the
@ symbol.

NOTE: This code is valid for only 24 hours from the time you enable HP Web Services. If
it expires, follow the instructions to enable HP Web Services again, and obtain a new code.

d. To prevent your product from printing unexpected documents, click ePrint Settings, and
then click the Allowed Senders tab. Click Allowed Senders Only, and add the e-mail
addresses from which you want to allow ePrint jobs.

e. To set up default settings for all ePrint jobs sent to this product, click ePrint Settings, click
Print Options, and select the settings that you want to use.

4. To print a document, attach it to an e-mail message sent to the product's e-mail address.

NOTE: The email will be printed once it is received. As with any email, there is no guarantee when,
or whether, it will be received. You can check the print status at www.eprintcenter.com.

NOTE: Documents printed with HP ePrint may appear different from the original. Style, formatting,
and text flow may differ from the original document. For documents that need to be printed with a
higher quality (such as legal documents), we recommend that you print from the software application
on your computer, where you will have more control over what your printout looks like.

Use the HP ePrint Mobile Driver
The HP ePrint Mobile Driver makes it easy to print from a desktop or laptop computer to any HP
ePrint-capable product. After installing the driver, open the Print option from within your application,
and then select HP ePrint Mobile from the installed printers list. This single driver makes it easy to
find HP ePrint-enabled products that are registered to your ePrintCenter account. The target HP
product can be at your desk or in a remote location, such as a branch office or across the globe—you
can do remote printing by using the Internet without file type or size limitations. The target product
can be anywhere in the world; if it is Web-connected and registered in ePrintCenter, you can send a
print job to the product.
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For Windows, the HP ePrint Mobile Driver also supports traditional direct IP printing to local network
printers on the network (LAN or WAN) to supported PostScript® products.

Go to www.hp.com/go/eprintmobiledriver for drivers and information.

Supported operating systems

● Windows® XP (32-bit, SP 2 or greater)

NOTE: Microsoft retired mainstream support for Windows XP in April 2009. HP will continue to
provide best-effort support for the discontinued XP operating system.

● Windows Vista® (32-bit and 64-bit)

● Windows 7 (32-bit and 64-bit)

● Windows .Net 3.5 SP1

NOTE: Windows .Net 3.5 is installed if you are not using the Add Printer wizard.

● Mac OS X v10.5 and v10.6

NOTE: The HP ePrint Mobile Driver is a PDF workflow utility for Mac, and is not technically a
print driver. HP ePrint Mobile for Mac supports print paths only through ePrintcenter and does
not support direct IP printing to local network printers.

AirPrint
Direct printing using Apple’s AirPrint is supported for iOS 4.2 and Mac OS X 10.7 or later. Use
AirPrint to print directly to the product from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch
(third generation or later) in the following mobile applications:

● Mail

● Photos

● Safari

● Select third-party applications

To use AirPrint, the product must be connected to a wireless network. For more information about
using AirPrint and about which HP products are compatible with AirPrint, go to www.hp.com/go/
airprint.

NOTE: You might need to upgrade the product firmware to use AirPrint. Go to www.hp.com/
support/ojpx451 or www.hp.com/support/ojpx551.

NOTE: When using the AirPrint driver, the options and settings will differ from the full-featured driver
provided by HP. This document describes the full-featured HP driver features.
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Connect the printer with HP Wireless Direct
Connect a computer, smart phone, tablet, or other Wi-Fi capable device directly to your HP printer
with HP Wireless Direct. With an HP Wireless Direct connection you can print wirelessly, without a
router, from your Wi-Fi capable devices.

● HP printing software is required for printing over Wireless Direct from a computer. A compatible
printing application is required for printing over Wireless Direct from a smart phone or tablet.

● A Wireless Direct connection is turned on and managed from the printer’s control panel.

● If your WiFi capable device supports WPA2 encryption, you can enable security when you setup
a Wireless Direct connection.

● Five devices or fewer can simultaneously use Wireless Direct to connect to your printer.

● A Wireless Direct connection can be used while your printer is also connected to a wireless
network or a USB cable.

● Wireless Direct cannot connect to the internet.

This section covers the following topics:

● Connect and print from a WiFi capable mobile device

● Connect and print from a WiFi capable computer over a wireless router and Wireless Direct

● Connect and print from a WiFi capable computer over Wireless Direct only

● Change from printing over USB to a Wireless Direct connection

Connect and print from a WiFi capable mobile device
1. Setup your printer. A compatible print application is required for printing from a mobile device. If

your mobile print application can print over a wireless network connection, you can print over
Wireless Direct.

NOTE: Compatible with mobile devices with HP ePrint mobile app installed, HP Printer Control
app installed, Apple devices with iOS 4.2+, and HP webOS devices.

2. Turn on your printer’s Wireless Direct connection.

● Press (X451 Series) or touch (X551 Series) the Setup  button from the control panel.

● Open the Network menu.

● Open the Wireless Direct menu.

● Select On to enable Wireless Direct connections or select On With Security to enable
secure, Wireless Direct connections to the printer.

3. Turn on your mobile device’s Wi-Fi capability.

4. From your mobile device, search for and connect to the Wireless Direct name for your printer,
such as HP-Setup-xx-Officejet Pro X551.

5. From your mobile device’s print application, confirm your HP printer is the default printer, select
print, and then print your document.
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Connect and print from a WiFi capable computer over a wireless router
and Wireless Direct

1. Setup and install your printer over a wireless router. Make sure you can successfully print over
your wireless router before proceeding.

2. Turn on your printer’s Wireless Direct connection.

● Press (X451 Series) or touch (X551 Series) the Setup  button from the control panel.

● Open the Network menu.

● Open the Wireless Direct menu.

● Select On to enable Wireless Direct connections or select On With Security to enable
secure, Wireless Direct connections to the printer.

3. Turn on your computer’s Wi-Fi capability.

4. From your computer, search for and connect to the Wireless Direct name for your printer, such
as HP-Setup-xx-Officejet Pro X551.

5. From your computer, select print, and then confirm to print your document.

Connect and print from a WiFi capable computer over Wireless Direct only
1. Setup your printer, but do not install the HP printer software.

2. Turn on your printer’s Wireless Direct connection.

● Press (X451 Series) or touch (X551 Series) the Setup  button from the control panel.

● Open the Network menu.

● Open the Wireless Direct menu.

● Select On to enable Wireless Direct connections or select On With Security to enable
secure, Wireless Direct connections to the printer.

3. Turn on your computer’s Wi-Fi capability.

4. From your computer, search for and connect to the Wireless Direct name for your printer, such
as HP-Setup-xx-Officejet Pro X551.

5. Install the HP printer software.

● When the Connection Options software screen is shown, select Wireless.

● When the list of detected printers is shown, select your HP printer, and then finish installing.

Change from printing over USB to a Wireless Direct connection
Follow these steps after setting up your printer with a USB connection.

1. Turn on your printer’s Wireless Direct connection.

● Press (X451 Series) or touch (X551 Series) the Setup  button from the control panel.

● Open the Network menu.
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● Open the Wireless Direct menu.

● Select On to enable Wireless Direct connections or select On With Security to enable
secure, Wireless Direct connections to the printer.

2. Turn on your computer’s Wi-Fi capability.

3. From your computer, search for and connect to the Wireless Direct name for your printer, such
as HP-Setup-xx-Officejet Pro X551.

4. From your computer, configure the printer software to print over Wireless Direct.

a. Select Windows Start button > All Programs > HP > HP Officejet Pro X551 MFP
SeriesPrinter Setup & Software

b. Select Connect New Printer.

IMPORTANT: Do not select Convert a USB connected printer to wireless.

c. When the Connection Options software screen is shown, select Wireless.

d. When the list of detected printers is shown, select your HP printer, and then finish installing.

5. When you want to print over Wireless Direct, select your printer labeled (Network) from the
Windows Printers group in the software application that you are using.

NOTE: There are will be two instances of your printer in the Printers group, so be sure to
select the printer named HP Officejet Pro X551 MFP Series(Network).

Plug and Print USB Drive printing

For Officejet Pro X551 Series printers
This product features printing from a USB flash drive so you can quickly print files without sending
them from a computer. The product accepts standard USB storage accessories in the USB ports on
the front and back of the product. You can print the following types of files:

● .PDF

● .JPEG

● .JPG

● .PNG

● .TIFF
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1. Insert the USB drive into the USB port on the
front or back of the product. The Plug and
Print menu opens.

 

2. Select a document from the list of documents
and folders on the USB device.

 

3. Touch the Settings... button to modify the
print settings for the job, if necessary.

 

4. Touch Start Black or Start Color to start the
print job.

 

5. To scan a document and save it as a .JPEG
or .PDF file onto the USB drive, load the
document onto the scanner glass or into the
document feeder. Touch the Scan to USB
Drive item. Touch the Settings... button to
adjust the scan settings.
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9 Color

● Adjust color

● Use the HP EasyColor option

● Match colors to your computer screen

● Print fade- and water-resistant prints

Adjust color
Manage color by changing the settings on the Color (Windows) and Color Options tab (Mac) in the
printer driver.

Change the color theme for a print job
1. On the File menu in the software program, click Print.

2. Click Properties or Preferences (Windows).

3. Click the Color tab (Windows) or Color Options tab (Mac) and uncheck HP EasyColor.

4. Select a color theme from the Color Themes (Windows) or RGB Color (Mac) drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When
using this theme, manage color in the software program or in the operating system for
correct rendering.

● Vivid: The product increases the color saturation in the midtones. Use this theme when
printing business graphics.

● Photo: The product interprets RGB color as if it were printed as a photograph using a
digital mini lab. The product renders deeper, more saturated colors differently than with the
Default (sRBG) theme. Use this theme when printing photos.
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● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the
AdobeRGB color space rather than sRGB. Turn off color management in the software
program when using this theme.

● None: No color theme is used.

Change the color options
Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click the Print item.

2. Click Properties or Preferences (Windows).

3. Click the Color tab (Windows) or Color Options tab (Mac).

4. Clear the HP EasyColor check box.

5. Click the Ink Settings button (Windows) or expand the Advanced menu (Mac), and then use the
slider to make the following adjustments:

● Dry Time

● Saturation

● Black Ink Spread

NOTE: Changing color settings manually can impact output. HP recommends that only
color graphics experts change these settings.
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NOTE: Changing color settings manually can impact output. HP recommends that only color
graphics experts change these settings.

6. Click OK so save your adjustments and close the window, or click Reset to return the settings to
the factory defaults (Windows).

7. Click the Print in Grayscale option (Windows) or Print Color as Gray (Mac) to print a color
document in black and shades of gray. Use this option to print color documents for photocopying
or faxing. You can also use this option to print draft copies or to save color cartridge life.

8. Click the OK button (Windows).

Use the HP EasyColor option
If you are using the HP PCL 6 printer driver for Windows, the HP EasyColor technology automatically
improves mixed-content documents that are printed from Microsoft Office programs. This technology
scans documents and automatically adjusts photographic images in .JPEG or .PNG format.
HP EasyColor technology enhances the entire image at one time, rather than dividing it into several
pieces, which results in improved color consistency, sharper details, and faster printing.
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If you are using the HP Postscript printer driver for Mac, HP EasyColor technology scans all
documents and automatically adjusts all photographic images with the same improved photographic
results.

In the following example, the images on the left were created without using the HP EasyColor option.
The images on the right show the enhancements that result from using the HP EasyColor option.

The HP EasyColor option is enabled by default in both the HP PCL 6 printer driver and the HP Mac
Postscript printer driver, so you do not need to make manual color adjustments. To disable the option
so you can manually adjust the color settings, open the Color tab in the Windows driver or the Color
Options tab in the Mac driver, and then click the HP EasyColor check box to clear it.

Match colors to your computer screen
For most users, the best method for matching colors is to print sRGB colors.

The process of matching printer output color to your computer screen is complex, because printers
and computer monitors use different methods of producing color. Monitors display colors by using
light pixels that use an RGB (red, green, blue) color process, but printers print colors by using a
CMYK (cyan, magenta, yellow, and black) process.
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Many factors can influence your ability to match printed colors to those on your monitor:

● Print media

● Printer colorants (inks or toners, for example)

● Printing process (inkjet, press, or laser technology, for example)

● Overhead lighting

● Personal differences in perception of color

● Software programs

● Printer drivers

● Computer operating systems

● Monitors

● Video cards and drivers

● Operating environment (humidity, for example)

Keep these factors in mind when colors on your screen do not perfectly match your printed colors.

Print fade- and water-resistant prints
HP Officejet pigment inks designed for business use are like liquid laser toner—providing
professional, durable color documents that stand up to handling and dry quickly. Print professional,
water-resistant documents on plain paper.

Not only do HP Officejet pigment inks offer vivid colors and bold blacks, they provide benefits over
traditional dye-based inks, including superior water and fade resistance and better durability. These
unique qualities are possible because the pigment solid does not dissolve in water but is dispersed to
prevent pigment settling. As a result, output resists rain and water spills, and you can handle
important documents with confidence.

HP Officejet inks for business are specifically developed for use with HP printheads. Unique ink
formulations help extend the life of the printheads and enhance reliability. When used with ColorLok®
paper, these inks provide laser-like color output that dries quickly and is ready for distribution.

NOTE: Based on HP internal testing using a range of plain papers, HP highly recommends using
papers with the ColorLok® logo for this product. For details, go to http://www.hp.com/go/
printpermanence.
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10 Manage and maintain

● Print information pages

● Use the HP Embedded Web Server

● Use HP Web Jetadmin software

● Product security features

● Economy settings

● Clean the product

● Product updates

Print information pages
Information pages reside within the product memory. These pages help diagnose and solve problems
with the product.

NOTE: If the product language was not correctly set during installation, you can set the language
manually so the information pages print in one of the supported languages. Change the language by
using the Device Setup menu on the control panel or the HP Embedded Web Server.

1. From the Home screen, press the Setup  button.

2. Press the Print Reports button.

3. Select the name of the report that you want to print.

Menu Item Sub Menu Item Description

Printer Status Report  Prints the ink cartridge status. Includes the following information:

● Estimated percentage of cartridge life remaining

● Approximate pages remaining

● Part numbers for HP ink cartridges

● Number of pages printed

Print Quality Report  Prints a page that helps solve problems with print quality

Usage Page  Shows a count of all paper sizes that have passed through the product; lists
whether they were monochrome or color, simplex or duplex, and reports the
page count. This report is useful for reconciling contractual billing statements.
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Menu Item Sub Menu Item Description

Network Configuration
Page

 Displays status for:

● Network hardware configuration

● Enabled features

● TCP/IP and SNMP information

● Network statistics

● Wireless network configuration (wireless models only)

● Usage page

● PCL6 Font list

Event Log  Prints a log of errors and other events during product use.

PCL Font List  Prints a list of all installed PCL  fonts

PS Font List  Prints a list of all installed PS fonts

Use the HP Embedded Web Server
This product is equipped with an embedded Web server (EWS), which provides access to information
about product and network activities. A Web server provides an environment in which Web programs
may run, much in the same way that an operating system, such as Windows, provides an
environment for programs to run on a computer. The output from these programs can then be
displayed by a Web browser.

An “embedded” Web server resides on a hardware device (such as an HP  printer) or in firmware,
rather than as software that is loaded on a network server.

The advantage of an EWS is that it provides an interface to the product that anyone with a network-
connected product and computer can use. There is no special software to install or configure, but you
must have a supported Web browser on the computer. To gain access to the EWS, type the IP
address for the product in the address line of the browser.

NOTE: For Macintosh operating systems, you can use the HP EWS over a USB connection after
installing the Macintosh software included with the product.

About cookies
The HP EWS places very small text files (cookies) on your hard drive when you are browsing. These
files let the HP EWS recognize your computer the next time you visit. For example, if you have
configured the HP EWS language, a cookie helps remember which language you have selected so
that the next time you access the HP EWS, the pages are displayed in that language. Though some
cookies are cleared at the end of each session (such as the cookie that stores the selected
language), others (such as the cookie that stores customer-specific preferences) are stored on the
computer until you clear them manually.

IMPORTANT: The cookies that the HP EWS stores on your computer are only used for saving
settings on your computer or for sharing information between the printer and the computer. These
cookies are not sent to any HP Websites.
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You can configure your browser to accept all cookies, or you can configure it to alert you every time a
cookie is offered, which allows you to decide which cookies to accept or refuse. You can also use
your browser to remove unwanted cookies.

Depending on your printer, if you disable cookies, you also disable one or more of the following
features:

● Starting where you left the application (especially useful when using setup wizards).

● Remembering the HP EWS browser language setting.

● Personalizing the HP EWS Home page.

For information about how to change your privacy and cookie settings and how to view or delete
cookies, see the documentation available with your Web browser.

Open the HP Embedded Web Server
To open the HP Embedded Web Server (HP EWS), type the IP address or host name of the product
in the address field of a supported Web browser. To find the IP address, print a Printer Status Report
or Network Configuration Page, or get the IP address from the product control panel.

You can also open the HP EWS from the Windows printer driver. Open the Services tab and then
click the Device and Supplies Status icon.

For Mac, the HP EWS can be opened from the HP Utility or from System Preferences -> Print &
Scan -> [product name] -> Options & Supplies -> General -> Show Printer Webpage.

NOTE: If an error occurs while opening the HP EWS, confirm that the proxy settings are correct for
your network.

TIP: After you open the URL, bookmark it so that you can return to it quickly in the future.

Features
● Home tab

● Web Services tab

● Network tab

● Tools Tab

● Settings Tab

NOTE: Changing network settings in the HP EWS might disable some of product, or product
software or features.

Home tab

Use the Home tab to customize various views and tasks related to your device. The Home tab
includes the following items:
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NOTE: Not all of the following items are visible by default. Use the Personalize this page button
show or hide the items of your choice.

● Recently Visited: Displays 5 most recently visited embedded HP EWS links

● Printer Status: Displays current printer status.

● Diagnostic: Provide links to diagnostic tasks.

● ePrint: Displays the status of ePrint connection.

● Ink Level Status: Displays ink level status.

● Manage: Useful links for managing the HP EWS.

● Wired Network Status: Displays wired (802.3) status or wired (802.11) status (wireless
models).

● Setup: Displays setup options.

● Custom Shortcut: Customize quick links to be added as shortcut.

● Support: Links to Hewlett-Packard's support Web site.

NOTE: Settings for this page are automatically saved in the Web browser's cookies. If the Web
browser's cookies are deleted, these settings are lost.

Web Services tab

Use the HP Web Services tab to configure and enable HP Web Services for this product. You must
enable HP Web Services to use the HP ePrint feature.

Network tab

Use the Network tab to configure and secure network settings for the product when it is connected to
an IP-based network. This tab does not display if the product is connected to other types of networks.

Tools Tab

Product Information

● Printer Information: Find basic device information such as serial number, name and firmware
version.

● Ink Gauge: See estimated ink levels, ink cartridge part numbers, and estimated printable pages
remaining for each cartridge.

● Ink Settings: Change the threshold at which the printer provides the "Low on Ink" notification.

Reports

● Usage Report: View the number of pages processed for printing, scanning, copying and faxing.

● Printer Reports: Print various reports.

● Event Log: View logged events such as firmware errors.
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Utilities

● Bookmarking: Bookmark pages in the HP EWS.

● Print Quality Toolbox: Run maintenance tools to improve the print quality of your printouts.

● Asset Tracking: Assign an asset number/location to this device.

Backup and Restore

● Backup: Create a password-encrypted file that stores the printer's settings.

● Restore: Restore the printer's settings using a backup file created by the HP EWS.

Job Management

● Job Monitor: Monitor or cancel jobs currently active or pending in the printer.

Printer Restart

● Power Cycle: Allows you to turn off and restart the printer.

Settings Tab

Set and maintain various options on your product including power management, date and time,
security, printing, and paper settings, email alerts, default copy settings, restore factory defaults and
firewall settings.

Use HP Web Jetadmin software
HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of
networked HP devices, including printers, multifunction products, and digital senders. This single
solution allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and
imaging environment — ultimately increasing business productivity by helping you save time, control
costs, and protect your investment.

HP Web Jetadmin updates are periodically made available to provide support for specific product
features. Visit www.hp.com/go/webjetadmin and click the Self Help and Documentation link to learn
more about updates.

Product security features

Security statements
This product supports security standards and protocols that help secure the product, protect
information on your network, and simplify monitoring and maintenance of the product.

For information about HP's secure imaging and printing solutions, visit www.hp.com/go/
Secureprinting. The site provides links to white papers and FAQ documents about security features
and may include information about additional security features that are not contained in this
document.

ENWW Use HP Web Jetadmin software 111

http://www.hp.com/go/webjetadmin
http://www.hp.com/go/Secureprinting
http://www.hp.com/go/Secureprinting


Assign an administrator password in the HP Embedded Web Server
The HP Embedded Web Server allows you to assign an administrator password so that unauthorized
users cannot change product configuration settings in the HP Embedded Web Server. When the
admin password is assigned and applied, you must enter the password to make any configuration
changes that are done through the HP Embedded Web Server. If you change an existing password,
you must first enter that password. You can also remove the password by entering the existing
password and then deleting the assigned password.

Control Panel Lock
The HP Embedded Web Server allows the ability to lock certain features on the product’s control
panel to prevent unauthorized use. Once the control panel lock is enabled, certain control panel
configuration features cannot be changed from the control panel. The control panel lock setting itself
can also be secured. This is accomplished by setting the HP Embedded Web Server administrator
password. Once the HP Embedded Web Server administrator password is set, the admin password
must be entered when accessing the control panel lock enable/disable setting.

Disable unused protocols and services
The HP Embedded Web Server allows the ability to disable unused protocols and services. These
protocol and services settings can also be protected from being changed by setting the EWS admin
password. These protocols and services include the following:

● IPv4 and IPv6 disable/enable: To operate properly on a TCP/IP network, the product must be
configured with valid TCP/IP network configuration settings, such as an IP address that is valid
for your network. This product supports two versions of this protocol: version 4 (IPv4) and
version 6 (IPv6). IPv4 and IPv6 can be enabled/disable individually or simultaneously enabled.

● Bonjour disable/enable: Bonjour services are typically used on small networks for IP address
and name resolution where conventional a DNS server is not used. The Bonjour service can be
enabled or disabled.

● SNMP disable/enable: SNMP (Simple Network Management Protocol) is used by network
management applications for product management. This product supports the SNMPv1 protocol
on IP networks. This product allows the ability to enable/disable SNMPv1.

● WINS disable/enable: If you have a Dynamic Host Configuration Protocol (DHCP) service on
your network, the product automatically obtains its IP address from that server and registers its
name with any RFC 1001 and 1002-compliant dynamic name services as long as the Windows
Internet Name Service (WINS) server IP address has been specified. The WINS server IP
address configuration can be enable or disabled. If enabled, then the primary and secondary
WINS server can be specified.

● SLP disable/enable: Service Location Protocol (SLP) is an Internet standard network protocol
that provides a framework to allow network applications to discover the existence, location and
configuration of networked services in enterprise networks. This protocol can be enabled or
disabled.

● LPD disable/enable: Line Printer Daemon (LPD) refers to the protocol and programs associated
with line-printer spooling services that may be installed on various TCP/IP systems. LPD can be
enabled or disabled.
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● LLMNR disable/enable: Link-Local Multicast Name Resolution (LLMNR) is a protocol based on
the Domain Name System (DNS) packet format that allows both IPv4 and IPv6 hosts to perform
name resolution for hosts on the same local link. LLMNR can be enabled or disabled.

● Port 9100 disable/enable: The product supports raw IP printing through TCP Port 9100. This
HP-propriety TCP/IP port on the product is the default port for printing and it is accessed by HP
software. Port 9100 can be enabled or disabled.

● Web Services disable/enable: The product supports the ability to enable or disable Microsoft
Web Services Dynamic Discovery (WS Discovery) protocols or Microsoft Web Services for
Devices (WSD) Print services supported on the product. These web services can be enabled or
disabled together or WS Discovery can be enabled separately.

● Internet Printing Protocol (IPP) disable/enable: Internet Printing Protocol (IPP) is an Internet-
standard protocol that allows you to print documents and manage jobs over the internet. IPP can
be disabled or enabled.

Administrator Settings
The HP Embedded Web Server allows the ability to enable and disable certain product capabilities.
These include network, Ethernet, wireless, wireless access point (i.e. disables wireless direct
capability), USB, fax, fax reprint, copy, digital send, webscan, control panel lock, color fax, color copy,
color print from memory devices, all web services, only ePrint, and only Apps. The product must be
turned off, and then turned on again, for settings to take effect.

Color Access Control
HP’s suite of color access control tools allows you to enable or disable color by individuals users or
groups and applications. For more information see www.hp.com/go/upd. The HP Embedded Web
Server also allows you to disable color faxing, color copying, and color print from memory devices.

Protected Protocols – HTTPS
The HP Embedded Web Server features the ability to enable encryption of product communication
through the HTTPS redirection feature. When used, HTTPS prevents others from viewing information
between the EWS and the product via encryption – providing a secure communication method.

Firewall
The HP Embedded Web Server allows the ability to enable and configure product firewall rules,
priorities, templates, services and policies. The firewall feature provides a network-layer of security on
both IPv4 and IPv6 networks. The firewall configuration capability provides control over IP addresses
that are allowed access the product, and the ability to set permissions and priorities for digital send,
management, discovery, and print services--providing a more secure way of controlling access to the
product.

Scan-to and Fax-to Folder Authentication
The Scan-to and Fax-to network folder allows sending to a network folder via the Windows file
sharing mechanism. A username and password may be required to log onto the network where the
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network folder is located. In addition, appropriate privileges may be required to have write access to
the network folder.

Syslog
Support of Syslog, a standard protocol for logging status messages to a designated server, can be
used to track the activities and status of devices on the network. The HP Embedded Web Service
provides the ability to enable Syslog and to specify the server to which the status messages will be
sent. Specifying the priority of those status messages is also supported.

Certificates
The HP Embedded Web Server provides the ability to install and manage certificates for the
authentication of product, server and network. This includes the ability to create a certificate, install a
certificate, and import and export certificates.

Signed Firmware
Support of digitally-signed firmware updates eliminates exposure to malicious software by preventing
the installation of non-approved firmware on the product.

Wireless Authentication
The HP Embedded Web Server provides the ability to configure wireless networking via such 802.1x
wireless enterprise authentication protocols as EAP-TLS, LEAP, and PEAP to support access control.
The HP Embedded Web Server also provides the ability to configure wireless dynamic key encryption
such as WEP encryption and WPA-PSK authentication. In addition, Wireless Direct Authentication
can be enabled or disabled.

Economy settings

Print with General Office mode
General Office print mode uses less ink, which might extend the life of the cartridge.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select General Office from the Print Quality drop-down box.

Power handling
The product includes features that can help reduce energy consumption

The Standby and Sleep After Standby modes reduce power consumption when the product has been
inactive for an extended period. You can set the length of time before the product enters Standby or
Sleep After Standby modes.
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The Schedule On/Off feature turns the product on or off after a certain length of time. You can adjust
this time-delay setting.

The Auto Power Off feature turns the product off after a certain length of time. You can adjust this
time delay setting.

Set Standby

1. From the Home screen, press (X451 Series) or touch (X551 Series) the Setup  button.

2. Open the following menus:

● Device Setup

● Power Handling

● Standby

3. Select the time for the standby delay.

NOTE: The default value is 10 minutes.

Set Sleep After Standby

1. From the Home screen, press (X451 Series) or touch (X551 Series) the Setup  button.

2. Open the following menus:

● Device Setup

● Power Handling

● Sleep After Standby

3. Select the time for the sleep after standby delay.

NOTE: The default is 2 hours after standby.

Schedule On/Off

1. From the Home screen, press (X451 Series) or touch (X551 Series) the Setup  button.

2. Open the following menus:

● Device Setup

● Power Handling

● Schedule On/Off

3. Enable Schedule On or Schedule Off and set the times for those events to take affect.
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Clean the product

Clean the control panel
Clean the touch screen whenever it is necessary to remove fingerprints or dust. Wipe the control
panel gently with a clean, water-dampened, lint-free cloth.

CAUTION: Use water only. Solvents or cleaners can damage the control panel. Do not pour or
spray water directly onto the touch screen.

Product updates
Software and firmware updates and installation instructions for this product are available at
http://www.hp.com/go/support. Click Support & Drivers, click the operating system, and then select
the download for the product.
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11 Solve problems

● Customer support

● Problem-solving checklist

● Restore the factory-set defaults

● Paper feeds incorrectly or becomes jammed

● Clear jams

● Improve print quality

● The product does not print or it prints slowly

● Solve Plug and Print USB Drive printing problems (X551 Series)

● Solve product connectivity problems

● Solve wireless network problems

● Solve product software problems with Windows

● Solve product software problems with Mac

Customer support

Get telephone support, free during your warranty period, for
your country/region

Have the product name, serial number, date of purchase,
and problem description ready.

Country/region phone numbers are on the flyer that was in
the box with your product or at www.hp.com/support/.

Get 24-hour Internet product support and troubleshooting
and download drivers and software, and electronic
information

http://www.hp.com/go/support

Get support for products used with a Macintosh computer www.hp.com/go/macosx

Download software utilities, drivers, and electronic
information

http://www.hp.com/go/support

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register your product www.register.hp.com

Problem-solving checklist
Follow these steps when trying to solve a problem with the product.

● Step 1: Check that the product power is on
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● Step 2: Check the control panel for error messages

● Step 3: Test print functionality

● Step 4: Try sending a print job from a computer

● Step 5: Test the Plug and Print USB Drive printing functionality (X551 Series)

● Factors that affect product performance

Step 1: Check that the product power is on
1. Make sure the product is plugged in and turned on.

2. Make sure the power cable is connected to the product and the outlet.

3. Check the power source by connecting the power cable to a different outlet.

4. If the product motors do not rotate, make sure the ink cartridges are installed and that the doors
are all closed. The control panel displays messages to indicate these problems.

Step 2: Check the control panel for error messages
The control panel should indicate ready status. If an error message appears, resolve the error.

Step 3: Test print functionality
1. From the control panel Home screen, press (X451 Series) or touch (X551 Series) the Setup 

button.

2. Open the Print Reports menu, and select the Printer Status Report to print the report.

3. If the report does not print, make sure paper is loaded in the tray, and check the control panel to
see if paper is jammed inside the product.

NOTE: Make sure the paper in the tray meets specifications for this product.

Step 4: Try sending a print job from a computer
1. Use a word-processing program to send a print job to the product.

2. If the job does not print, make sure you selected the correct printer driver.

3. Uninstall and then reinstall the product software.

Step 5: Test the Plug and Print USB Drive printing functionality (X551
Series)

1. Load a .PDF document or .JPEG photo onto a USB flash drive, and insert it in the slot on the
front or the back of the product.

2. The USB Print menu opens. Try printing the document or photo.

3. If no documents are listed, try a different type of USB flash drive.
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Factors that affect product performance
Several factors affect the time it takes to print a job:

● The software program that you are using and its settings

● The use of special paper (such as transparencies, heavy paper, and custom-size paper)

● Product processing and download time

● The complexity and size of graphics

● The speed of the computer you are using

● The USB or network connection

● Whether the product is printing in color or in monochrome

● The type of USB drive, if you are using one

Restore the factory-set defaults 
CAUTION: Restoring the factory-set defaults returns all of the product and network settings to the
factory defaults. The procedure then automatically restarts the product.

1. On the product control panel, press (X451 Series) or touch (X551 Series) the Setup  button.

2. Scroll to and press or touch the Tools menu button.

3. Scroll to and press or touch the Restore Factory Defaults button, and then touch the OK button.

The product automatically restarts.
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Paper feeds incorrectly or becomes jammed
● The product does not pick up paper

● The product picks up multiple sheets of paper

● Prevent paper jams

The product does not pick up paper
If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Align the
guides with the paper-size markings in the bottom of the tray.

4. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not
fan the paper. Return the stack of paper to the tray.

5. Check the product control panel to see if the product is waiting for you to acknowledge a prompt
to feed the paper manually through Tray 1, the multi-purpose tray on the left side of the product.
Load paper, and continue.

The product picks up multiple sheets of paper
If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not
fan the paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package. Make sure all paper in the tray is the same type and size.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return less paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Align the
guides with the paper-size markings in the bottom of the tray.

Prevent paper jams
To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product. Light-weight, short grain paper is
not recommended for use in this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

3. Use paper that has not previously been printed or copied on.
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4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

6. Make sure that the tray is fully inserted in the product.

7. If you are printing on heavy, embossed, or perforated paper, use Tray 1, the multi-purpose tray
on the left side of the printer, and then feed sheets manually one at a time.

Clear jams

Jam locations
Jams can occur in these locations:

1

5 34

2

1 Output bin

2 Left door

3 Optional Tray 3 and left jam-access door

4 Tray 1

5 Tray 2

Traces of ink might remain in the product after a jam and leave marks on the printed pages. This
problem typically resolves itself after a few sheets have been printed.
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Clear jams in Tray 1(Multi-purpose tray)

1. If the jammed sheet is visible and easily
accessible in Tray 1, pull it from Tray 1.

NOTE: If the sheet tears, make sure that all
of the fragments are removed before you
resume printing.

 

2. The jammed sheet may also be accessible by
removing Tray 2 and removing the jammed
sheet by pulling it to the right and then out of
the product.

 

3. If the jammed sheet is not visible or easily
accessible in Tray 1, open the left door to
access the jammed sheet.
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4. If the paper is still not visible or accessible,
remove the duplexer by pulling it out with both
hands. Set the duplexer aside, upright, on a
piece of paper to prevent ink spills.

CAUTION: When pulling out the duplexer,
avoid making direct contact with the black
cylinder to prevent ink smear on skin or
clothes.

 

5. Lower the platen by pressing down on the
green tab. This will cause the product to try to
feed the sheet through the print zone. You
may need to gently pull on the sheet if it does
not feed. Remove the sheet.

 

6. Lift the green tab to place the platen back into
its operating position.
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7. Reinstall the duplexer.  

8. Close the left door.  
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Clear jams in Tray 2

1. Open Tray 2 by pulling it out and releasing
the latch at the rear left of the tray.

 

2. Remove the jammed sheet by pulling it to the
right and then out of the product.

 

3. Close Tray 2.

NOTE: To close the tray, push in the middle
or with even pressure on both sides. Avoid
pushing on one side only.
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Clear jams in optional Tray 3

1. Open Tray 3.  

2. Remove the jammed sheet by pulling it to the
right and then out of the product.
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3. If the jam cannot be cleared at the tray, try
clearing the jam from the Tray 3 left door.

 

4. Close Tray 3.

NOTE: To close the tray, push in the middle
or with even pressure on both sides. Avoid
pushing on one side only.

 

Clear jams in the left door

1. Open the left door.  
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2. Gently remove any visible paper from the
rollers and delivery area.

NOTE: If the sheet tears, make sure that all
fragments are removed before you resume
printing. Do not use sharp objects to remove
fragments.

 

3. Close the left door.  
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Clear jams in the output bin

1. Look for jammed paper in the output bin area.  

2. Remove any visible media.

NOTE: If the sheet tears, make sure that all
fragments are removed before resuming
printing.

 

3. Open and then close the left door to clear the
message.

 

ENWW Clear jams 129



Clear jams in the duplexer

1. Open the left door.  

2. If you can see the trailing edge of the sheet,
remove the sheet from the product.

 

3. If the paper is not visible or accessible,
remove the duplexer by pulling it out with both
hands. Set the duplexer aside, upright, on a
piece of paper to prevent ink spills.

CAUTION: When pulling out the duplexer,
avoid making direct contact with the black
cylinder to prevent ink smear on skin or
clothes.
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4. Lower the platen by pressing down on the
green tab. This will cause the product to try to
feed the sheet through the print zone. You
may need to gently pull on the sheet if it does
not feed. Remove the sheet.

 

5. Lift the green tab to place the platen back into
its operating position.
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6. Reinstall the duplexer.  

7. Close the left door.  

Improve print quality
You can prevent most print-quality problems by following these guidelines.

● Use the correct paper type setting in the printer driver

● Adjust color

● Use paper that meets HP specifications

● Check the ink cartridges

● Clean ink smears

● Clean the printhead

● Use the printer driver that best meets your printing needs
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Use the correct paper type setting in the printer driver
Check the paper type setting if you are having any of the following problems:

● Ink is smearing on the printed pages.

● Repeated marks occur on the printed pages.

● Printed pages are curled.

● Printed pages have small unprinted areas.

Change the paper type and size setting for Windows

1. From a software program that has the Print feature available, click on the File menu, and then
click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand each category of paper types until you find the paper type that you are using.

7. Select the option for the type of paper you are using, and click the OK button.

Change the paper type and size setting for Mac

1. On the File menu in the software program, click the Print option.

2. Select a size from the Paper Size drop-down list.

3. Open the Paper/Quality menu.

4. Select a type from the Media Type drop-down list.

5. Click the Print button.

Adjust color
Manage color by changing the settings on the Color (Windows) and Color Options tab (Mac) in the
printer driver.

Change the color theme for a print job

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences (Windows).

3. Click the Color tab (Windows) or Color Options tab (Mac) and uncheck HP EasyColor.

4. Select a color theme from the Color Themes (Windows) or RGB Color (Mac) drop-down list.
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● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When
using this theme, manage color in the software program or in the operating system for
correct rendering.

● Vivid: The product increases the color saturation in the midtones. Use this theme when
printing business graphics.

● Photo: The product interprets RGB color as if it were printed as a photograph using a
digital mini lab. The product renders deeper, more saturated colors differently than with the
Default (sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the
AdobeRGB color space rather than sRGB. Turn off color management in the software
program when using this theme.

● None: No color theme is used.

Change the color options

Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click the Print item.

2. Click Properties or Preferences (Windows).

3. Click the Color tab (Windows) or Color Options tab (Mac).
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4. Clear the HP EasyColor check box.

5. Click the Ink Settings button (Windows) or expand the Advanced menu (Mac), and then use the
slider to make the following adjustments:

● Dry Time

● Saturation

● Black Ink Spread

NOTE: Changing color settings manually can impact output. HP recommends that only
color graphics experts change these settings.

NOTE: Changing color settings manually can impact output. HP recommends that only color
graphics experts change these settings.

6. Click OK so save your adjustments and close the window, or click Reset to return the settings to
the factory defaults (Windows).
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7. Click the Print in Grayscale option (Windows) or Print Color as Gray (Mac) to print a color
document in black and shades of gray. Use this option to print color documents for photocopying
or faxing. You can also use this option to print draft copies or to save color cartridge life.

8. Click the OK button (Windows).
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Use paper that meets HP specifications
Use different paper if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Specks of ink are on the printed pages.

● Ink is smearing on the printed pages.

● Printed characters seem misformed.

● Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines
when selecting paper:

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust,
wrinkles, voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that is designed for use in inkjet printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.

NOTE: Based on HP internal testing using a range of plain papers, HP highly recommends using
papers with the ColorLok® logo for this product. For details, go to http://www.hp.com/go/
printpermanence.

Check the ink cartridges
Check the ink cartridges by printing a status report, and replace them if necessary, if you are having
any of the following problems:

● Printed pages have small unprinted areas.

● Printed pages have streaks or bands.

NOTE: If you are using a draft print setting, the printing might appear light.

If you determine that you need to replace an ink cartridge, look on the cartridge or print the Supplies
Status Page to find the part number for the correct genuine HP ink cartridge.

Refilled or remanufactured ink cartridges

Hewlett-Packard Company cannot recommend the use of non-HP supplies, either new or
remanufactured. Because they are not HP products, HP cannot influence their design or control their
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quality. If you are using a refilled or remanufactured ink cartridge and are not satisfied with the print
quality, replace the cartridge with a genuine HP cartridge.

NOTE: If you replace a non-HP ink cartridge with a genuine HP ink cartridge, the printhead may still
contain non-HP ink until the printhead is depleted of that ink and is supplied with ink from the newly
installed, genuine HP ink cartridge.

Interpret the Print Quality Report

1. On the product control panel, press (X451 Series) or touch (X551 Series) the Setup  button.

2. Press or touch the Print Reports menu item.

3. Press or touch the Print Quality Report item to print it.

4. Follow the instructions on the page that prints.

This page contains four bands of color, which are divided into the groups as indicated in the following
illustration. By examining each group, you can isolate the problem to a particular ink color.

3

4

1

2

Section Ink cartridge

1 Black

2 Cyan
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Section Ink cartridge

3 Magenta

4 Yellow

● If dots or streaks appear in one or more groups, clean the printhead. If this does not solve the
problem, contact HP.

● If streaks appear in multiple color bands, see if the problem still persists by performing an
additional print head cleaning, and then contact HP. A component other than the ink cartridge is
probably causing the problem.

Inspect the ink cartridge for damage

1. Remove the ink cartridge from the product, and verify that there is no debris in the cartridge
path.

2. Examine the metal connector of the ink cartridge.

CAUTION: Do not touch the metal connector on the edge of the cartridge. Fingerprints on the
metal connector can cause print-quality problems.

3. If you see any scratches, or other damage on the metal connector, replace the ink cartridge.

4. If the metal connector does not appear to be damaged, push the cartridge gently back into its
slot until it locks in place. Print a few pages to see if the problem has resolved.
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Clean ink smears
Print a cleaning page to remove dust and excess ink from the printhead and paper path if you are
having any of the following problems:

● Specks of ink are on the printed pages.

● Ink is smearing on the printed pages.

● Repeated marks occur on the printed pages.

Use the following procedure to clean ink smears.

1. Load plain letter or A4 paper when you are prompted.

2. From the control panel, press (X451 Series) or touch (X551 Series) the Setup  button.

3. Press or touch the Tools menu button.

4. Press or touch the Clean Ink Smear menu button.

5. Press or touch the OK button to begin the cleaning process.

A page feeds through the product slowly. Retain this page for further print quality evaluation.

Clean the printhead
Printhead cleaning can help fix many print quality problems.

Use the following procedure to clean the printhead.

1. Load plain letter or A4 paper.

2. From the control panel, press (X451 Series) or touch (X551 Series) the Setup  button.

3. Press or touch the Tools menu button.

4. Press or touch the Clean Printhead menu button.

5. Press or touch the OK button to begin the cleaning process.

A page feeds through the product slowly. Retain this page for further print quality evaluation.

6. Follow the steps on the steps on the control panel.

Use the printer driver that best meets your printing needs
You might need to use a different printer driver if the printed page has unexpected lines in graphics,
missing text, missing graphics, incorrect formatting, or substituted fonts.
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HP PCL 6 driver ● Provided as the default driver. This driver is automatically installed when
using the CD.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for
postscript flash font support

● This driver is available for download at http://www.hp.com/go/upd.

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP Inkjet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single
driver for use with multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows
computer

● This driver is available for download at http://www.hp.com/go/upd.

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for
most users

● Developed to align with Windows Graphic Device Interface (GDI) for best
speed in Windows environments

● May not be fully compatible with third-party and custom solutions based on
PCL5

● This driver is available for download at http://www.hp.com/go/upd.

Download additional printer drivers from this Web site: http://www.hp.com/go/support.
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The product does not print or it prints slowly

The product does not print
If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.

◦ If the control panel does not indicate the product is ready, turn the product off and then on
again.

◦ If the control panel indicates the product is ready, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try to print a
test page from the control panel. If the test page prints, there may be a communication problem
between the product and the computer you are trying to print from.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check
the following items:

◦ Check the light next to the network connection on the product. If the network is active, the
light is green.

◦ Make sure that you are using a network cable and not a phone cord to connect to the
network.

◦ Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic printer drivers can
cause delays clearing jobs from the print queue.

5. From the list of printers on your computer, right-click the name of this product, click Properties,
and open the Ports tab.

◦ If you are using a network cable to connect to the network, make sure the printer name
listed on the Ports tab matches the product name on the product configuration page.

◦ If you are using a USB cable and are connecting to a wireless network, make sure the box
is checked next to Virtual printer port for USB.

6. If you are using a personal firewall system on the computer, it might be blocking communication
with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

7. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.
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The product prints slowly
If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of
specifications, go to this Web site: http://www.hp.com/go/support.

2. If the paper type setting is not correct for the type of paper you are using, change the setting to
the correct paper type.

3. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.

Solve Plug and Print USB Drive printing problems (X551
Series)

● The USB Print menu does not open when you insert the USB accessory

● The file does not print from the USB storage device

● The file that you want to print is not listed in the USB Print menu

The USB Print menu does not open when you insert the USB accessory
1. You might be using a USB storage device or a file system that this product does not support.

Save the files on a standard USB storage device that uses File Allocation Table (FAT) file
systems. The product supports FAT12, FAT16, and FAT32 USB storage accessories.

2. If another menu is already open, close that menu and then reinsert the USB storage device.

3. The USB storage device might have multiple partitions. (Some USB storage device
manufacturers install software on the accessory that creates partitions, similar to a CD.)
Reformat the USB storage device to remove the partitions, or use a different USB storage
device.

4. The USB storage device might require more power than the product can provide.

a. Remove the USB storage device.

b. Turn the product off and then on.

c. Use a USB storage device that has its own power supply or that requires less power.

5. The USB storage device might not be functioning correctly.

a. Remove the USB storage device.

b. Turn the product off and then on.

c. Try printing from another USB storage device.

The file does not print from the USB storage device
1. Make sure paper is in the tray.

2. Check the control panel for messages. If paper is jammed in the product, clear the jam.
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The file that you want to print is not listed in the USB Print menu
1. You might be trying to print a file type that the USB printing feature does not support. The

product supports .PDF, PNG, .and JPEG file types.

2. You might have too many files in a single folder on the USB storage accessory. Reduce the
number of files in the folder by moving them to subfolders.

3. You might be using a character set for the file name that the product does not support. In this
case, the product replaces the file names with characters from a different character set. Rename
the files using ASCII characters.

Solve product connectivity problems 

Solve USB direct-connect problems
If you have connected the product directly to a computer, check the USB cable.

● Verify that the cable is connected to the computer and to the product.

● Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.

● Verify that the cable is working correctly by connecting it with another product. Replace the cable
if necessary.

Solve network problems
Check the following items to verify that the product is communicating with the network. Before
beginning, print a configuration page from the product control panel and locate the product IP
address that is listed on this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

Poor physical connection

1. Verify that the product is attached to the correct ethernet port using the proper cable.

2. Verify that cable connections are securely attached.

3. Look at the ethernet port on the back of the product, and verify that the amber activity light and
the green link-status light are active.

4. If the problem continues, try a different cable or port on the network router, switch, or hub.
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The computer is using the incorrect IP address for the product

1. On the computer, open the printer properties and click the Ports tab. Verify that the current IP
address for the product is selected. The product IP address is listed on the product configuration
page or through the control panel.

2. If you installed the product using an HP standard TCP/IP port, select the box labeled Always
print to this printer, even if its IP address changes.

3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of
the IP address.

4. If the IP address is correct, delete the product entry from the list of installed printers, and then
add it again.

The computer is unable to communicate with the product

1. Test network communication by pinging the product.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the IP address for your product.

c. If the window displays round-trip times, both the network and device are working.

2. If the ping command failed, verify that the network router, hubs, or switches are on, and then
verify that the network settings, the product, and the computer are all configured for the same
network.

The product is using incorrect link and duplex settings for the network

Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). If you
change these settings, you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct printer
driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, printer drivers, and the network redirection.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if
necessary.

2. Reconfigure the network settings if necessary.
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Solve wireless network problems
● Wireless connectivity checklist

● The control panel displays the message: The wireless feature on this product has been turned
off

● The product does not print after the wireless configuration completes

● The product does not print, and the computer has a third-party firewall installed

● The wireless connection does not work after moving the wireless router or product

● Cannot connect more computers to the wireless product

● The wireless product loses communication when connected to a VPN

● The network does not appear in the wireless networks list

● The wireless network is not functioning

Wireless connectivity checklist
● The product and the wireless router are turned on and have power. Also make sure the wireless

radio in the product is turned on.

● The service set identifier (SSID) is correct. Print a configuration page to determine the SSID. If
you are not sure the SSID is correct, run the wireless setup again.

● With secured networks, make sure the security information is correct. If the security information
is incorrect, run the wireless setup again.

● If the wireless network is working correctly, try accessing other computers on the wireless
network. If the network has Internet access, try connecting to the Internet over another wireless
connection.

● The encryption method (AES or TKIP) is the same for the product as it is for the wireless access
point, such as a wireless router (on networks using WPA security).

● The product is within the range of the wireless network. For most networks, the product must be
within 30 m (100 ft) of the wireless access point (wireless router).

● Obstacles do not block the wireless signal. Remove any large metal objects between the access
point and the product. Make sure poles, walls, or support columns containing metal or concrete
do not separate the product and wireless access point.

● The product is located away from electronic devices that might interfere with the wireless signal.
Many devices can interfere with the wireless signal including motors, cordless phones, security
system cameras, other wireless networks, and some Bluetooth devices.

● The printer driver is installed on the computer.

● You have selected the correct printer port.

● The computer and product connect to the same wireless network.
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The control panel displays the message: The wireless feature on this
product has been turned off

1. Touch the Setup  button, and then touch the Wireless Setup menu.

2. Touch the Turn Wireless On/Off button, and then touch the On button.

The product does not print after the wireless configuration completes
1. Make sure the product is turned on and in the ready state.

2. Make sure you are connecting to the correct wireless network.

3. Make sure that the wireless network is working correctly.

a. On the control panel, touch the Setup  button, and then touch the Network menu item.

b. Select the Print Wireless Network Test item to test the wireless network. The product prints
a report with the results.

4. Make sure that the correct port or product is selected.

a. For printers installed without the fully-featured installer:

1. From the list of printers on your computer, right-click the name of this product, click
Properties, and then open the Ports tab.

2. Make sure the box is checked next to Virtual printer port for USB.

b. If you installed the product using the CD installer, or downloaded the fully-featured installer
from the HP's web site, you can view or change the product IP address using the following
steps:

i. Click Start.

ii. Click All Programs.

iii. Click HP.

iv. Click your product.

v. Click Update IP Address to open a utility that reports the known (“previous”) IP
address for the product and allows you to change the IP address, if necessary.

5. Make sure that your computer is working correctly. If necessary, restart your computer.

The product does not print, and the computer has a third-party firewall
installed

1. Update the firewall with the most recent update available from the manufacturer.

2. If programs request firewall access when you install the product or try to print, make sure you
allow the programs to run.

3. Temporarily turn off the firewall, and then install the wireless product on the computer. Enable
the firewall when you have completed the wireless installation.
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The wireless connection does not work after moving the wireless router or
product

Make sure that the router or product connects to the same network that your computer connects to.

1. From the control panel, touch the Setup  button, and then touch the Print Reports menu.

2. Select the Network Configuration Page item to print the report.

3. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer
configuration for your computer.

4. If the SSIDs are not the same, the devices are not connecting to the same network. Reconfigure
the wireless setup for your product.

Cannot connect more computers to the wireless product
1. Make sure that the other computers are within the wireless range and that no obstacles block

the signal. For most networks, the wireless range is within 30 m (100 ft) of the wireless access
point.

2. Make sure the product is turned on and in the ready state.

3. Turn off any third-party firewalls on your computer.

4. Make sure that the wireless network is working correctly.

a. On the product control panel, touch the Setup  button, and then touch the Network
menu.

b. Touch the Print Wireless Test Report item to test the wireless network. The product prints a
report with the results.

5. Make sure that the correct port or product is selected.

a. For printers installed without the fully-featured installer:

1. From the list of printers on your computer, right-click the name of this product, click
Properties, and then open the Ports tab.

2. Make sure the box is checked next to Virtual printer port for USB.

b. If you installed the product using the CD installer, or downloaded the fully-featured installer
from the HP's web site, you can view or change the product IP address using the following
steps:

i. Click Start.

ii. Click All Programs.

iii. Click HP.

iv. Click your product.

v. Click Update IP Address to open a utility that reports the known (“previous”) IP
address for the product and allows you to change the IP address, if necessary.

6. Make sure that your computer is working correctly. If necessary, restart your computer.
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The wireless product loses communication when connected to a VPN
● Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list
● Make sure the wireless router is turned on and has power.

● The network might be hidden. However, you can still connect to a hidden network.

The wireless network is not functioning
1. To verify if the network has lost communication, try connecting other devices to the network.

2. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the service set identifier (SSID) for your network.

c. If the window displays round-trip times, the network is working.

3. Make sure that the router or product connects to the same network that your computer connects
to.

a. From the product control panel, touch the Setup  button, and then touch the Print
Reports menu.

b. Touch the Network Configuration Page item to print the report.

c. Compare the service set identifier (SSID) on the configuration report to the SSID in the
printer configuration for your computer.

d. If the SSIDs are not the same, the devices are not connecting to the same network.
Reconfigure the wireless setup for your product.

Solve product software problems with Windows

Problem Solution

A printer driver for the product is
not visible in the Printer folder

Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the
system tray, right-click the icon, and select Close or Disable.

 Try plugging the USB cable into a different USB port on the computer.

An error message was
displayed during the software
installation

Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the task
bar, right-click the icon, and select Close or Disable.

 Check the amount of free space on the drive where you are installing the product software. If
necessary, free up as much space as you can, and reinstall the product software.

 If necessary, run the Disk Defragmenter, and reinstall the product software.
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Problem Solution

The product is in Ready mode,
but nothing prints

Print a Configuration page, and verify the product functionality.

 Verify that all of the cables are correctly seated and within specifications. This includes the USB and
power cables. Try a new cable.

 Verify the IP Address on the Configuration Page matches the IP address for the software port. Use
one of the following procedures:

 Windows XP, Windows Server
2003, Windows Server 2008,
and Windows Vista

1. Click Start.

2. Click Settings.

3. Click Printers and Faxes (using the default Start menu view)
or click Printers (using the Classic Start menu view).

4. Right-click the product driver icon, and then select Properties.

5. Click the Ports tab, and then click Configure Port.

6. Verify the IP address, and then click OK or Cancel.

7. If the IP Addresses are not the same, delete the driver, and
reinstall the driver using the correct IP address.

 Windows 7 1. Click Start.

2. Click Devices and Printers.

3. Right-click the product driver icon, and then select Printer
properties.

4. Click the Ports tab, and then click Configure Port.

5. Verify the IP address, and then click OK or Cancel.

6. If the IP Addresses are not the same, delete the driver, and
reinstall the driver using the correct IP address.

 

 Windows XP, Windows Server
2003, Windows Server 2008,
and Windows Vista, Windows 7,
installed using the fully-featured
installer

1. Click Start.

2. Click All Programs.

3. Click HP.

4. Click your product.

5. Click Update IP Address to open a utility that reports the
known (“previous”) IP address for the product and allows you
to change the IP address, if necessary.

Solve product software problems with Mac
● The printer driver is not listed in the Print & Fax list

● The product name does not appear in the product list in the Print & Fax list

● The printer driver does not automatically set up the selected product in the Print & Fax list

● A print job was not sent to the product that you wanted

150 Chapter 11   Solve problems ENWW



● When connected with a USB cable, the product does not appear in the Print & Fax list after the
driver is selected.

● You are using a generic printer driver when using a USB connection

The printer driver is not listed in the Print & Fax list
1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/

PPDs/Contents/Resources. If necessary, reinstall the software.

2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

The product name does not appear in the product list in the Print & Fax
list

1. Make sure that the cables are connected correctly and the product is on.

2. Print a configuration page to check the product name. Verify that the name on the configuration
page matches the product name in the Print & Fax list.

3. Replace the USB or ehternet cable with a high-quality cable.

The printer driver does not automatically set up the selected product in
the Print & Fax list

1. Make sure that the cables are connected correctly and the product is on.

2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

4. Replace the USB or ehternet cable with a high-quality cable.

A print job was not sent to the product that you wanted
1. Open the print queue and restart the print job.

2. Another product with the same or similar name might have received your print job. Print a
configuration page to check the product name. Verify that the name on the configuration page
matches the product name in the Print & Fax list.

When connected with a USB cable, the product does not appear in the
Print & Fax list after the driver is selected.

Software troubleshooting

▲ Make sure that your Mac operating system is Mac OS X 10.6 or later.
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Hardware troubleshooting

1. Make sure that the product is turned on.

2. Make sure that the USB cable is connected correctly.

3. Make sure that you are using the appropriate high-speed USB cable.

4. Make sure that you do not have too many USB devices drawing power from the chain.
Disconnect all of the devices from the chain, and connect the cable directly to the USB port on
the computer

5. Check to see if more than two non-powered USB hubs are connected in a row on the chain.
Disconnect all of the devices from the chain, and then connect the cable directly to the USB port
on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic printer driver when using a USB connection
If you connected the USB cable before you installed the software, you might be using a generic
printer driver instead of the driver for this product.

1. Delete the generic printer driver.

2. Reinstall the software from the product CD. Do not connect the USB cable until the software
installation program prompts you.

3. If multiple printers are installed, make sure that you have selected the correct printer in the
Format For drop-down menu in the Print dialog box.
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A Supplies and accessories

● Order parts, accessories, and supplies

● Part numbers

Order parts, accessories, and supplies

Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Part numbers

Item Part number Cartridge number Description

Ink cartridges CN621A HP 970 Standard-capacity black ink cartridge with HP Officejet
pigment ink

CN625A HP 970XL High-capacity black ink cartridge with HP Officejet
pigment ink

CN622A HP 971 Standard-capacity cyan ink cartridge with HP Officejet
pigment ink

CN626A HP 971XL High-capacity cyan ink cartridge with HP Officejet pigment
ink

CN624A HP 971 Standard-capacity yellow ink cartridge with HP Officejet
pigment ink

CN628A HP 971XL High-capacity yellow ink cartridge with HP Officejet
pigment ink

CN623A HP 971 Standard-capacity magenta ink cartridge with HP Officejet
pigment ink

CN627A HP 971XL High-capacity magenta ink cartridge with HP Officejet
pigment ink

Paper-
handling
accessories

CN595A  500-sheet paper feeder (optional Tray 3)

USB cable 8121-0868  2-meter A-to-B cable
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NOTE: For information about the yield for the cartridges, see www.hp.com/go/pageyield. Actual
yield depends on specific use.

Some ink cartridges may not be available in all regions.
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B Service and support

● Hewlett-Packard limited warranty statement

● End User License Agreement

● OpenSSL

● Customer support

Hewlett-Packard limited warranty statement

HP PRODUCT DURATION OF LIMITED WARRANTY

HP Officejet Pro X451dn, X451dw, X551dw 1 year

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from
defects in materials and workmanship after the date of purchase, for the period specified above. If HP
receives notice of such defects during the warranty period, HP will, at its option, either repair or
replace products which prove to be defective. Replacement products may be either new or equivalent
in performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date
of purchase, for the period specified above, due to defects in material and workmanship when
properly installed and used. If HP receives notice of such defects during the warranty period, HP will
replace software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is
unable, within a reasonable time, to repair or replace any product to a condition as warranted, you will
be entitled to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been
subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or
calibration, (b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized
modification or misuse, (d) operation outside of the published environmental specifications for the
product, or (e) improper site preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND
NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
Some countries/regions, states or provinces do not allow limitations on the duration of an implied
warranty, so the above limitation or exclusion might not apply to you. This warranty gives you specific
legal rights and you might also have other rights that vary from country/region to country/region, state
to state, or province to province.
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HP's limited warranty is valid in any country/region or locality where HP has a support presence for
this product and where HP has marketed this product. The level of warranty service you receive may
vary according to local standards. HP will not alter form, fit or function of the product to make it
operate in a country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT
ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT
WILL HP OR ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL,
INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE,
WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or
provinces do not allow the exclusion or limitation of incidental or consequential damages, so the
above limitation or exclusion may not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION
TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT
TO YOU.

End User License Agreement
PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User
License Agreement (“EULA”) is a contract between (a) you (either an individual or the entity you
represent) and (b) Hewlett-Packard Company (“HP”) that governs your use of the software product
(“Software”). This EULA does not apply if there is a separate license agreement between you and HP
or its suppliers for the Software, including a license agreement in online documentation. The term
“Software” may include (i) associated media, (ii) a user guide and other printed materials, and (iii)
“online” or electronic documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO
ALL TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING,
OR OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU
DO NOT ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE
SOFTWARE. IF YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA,
PLEASE RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN
DAYS FOR A REFUND OF THE PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR
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MADE AVAILABLE WITH ANOTHER HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED
PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software
(“HP Software”), software under licenses from third parties (“Third Party Software” and “Third
Party License”). Any Third Party Software is licensed to you subject to the terms and conditions
of the corresponding Third Party License. Generally, the Third Party License is in a file such as
“license.txt” or a “readme” file. You should contact HP support if you cannot find a Third Party
License. If the Third Party Licenses include licenses that provide for the availability of source
code (such as the GNU General Public License) and the corresponding source code is not
included with the Software, then check the product support pages of HP's website (hp.com) to
learn how to obtain such source code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and
conditions of this EULA:

a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing,
copying, storing, loading, executing, displaying, or otherwise using the HP Software. You
may not modify the HP Software or disable any licensing or control feature of the
HP Software. If this Software is provided by HP for Use with an imaging or printing product
(for example, if the Software is a printer driver, firmware, or add-on), the HP Software may
only be used with such product (“HP Product”). Additional restrictions on Use may appear
in the User Documentation. You may not separate component parts of the HP Software for
Use. You do not have the right to distribute the HP Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the
HP Software, provided each copy contains all the original HP Software’s proprietary notices
and is used only for back-up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement
(collectively “Upgrade”), you must first be licensed for the original HP Software identified by HP
as eligible for the Upgrade. To the extent the Upgrade supersedes the original HP Software, you
may no longer use such HP Software. This EULA applies to each Upgrade unless HP provides
other terms with the Upgrade. In case of a conflict between this EULA and such other terms, the
other terms will prevail.

4. TRANSFER.

a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer
of the HP Software to another end user. Any transfer will include all component parts,
media, User Documentation, this EULA, and if applicable, the Certificate of Authenticity.
The transfer may not be an indirect transfer, such as a consignment. Prior to the transfer,
the end user receiving the transferred Software will agree to this EULA. Upon transfer of
the HP Software, your license is automatically terminated.

b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for
commercial timesharing or bureau use. You may not sublicense, assign or otherwise
transfer the HP Software except as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User
Documentation are owned by HP or its suppliers and are protected by law, including applicable
copyright, trade secret, patent, and trademark laws. You will not remove any product
identification, copyright notice, or proprietary restriction from the Software.
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6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or
disassemble the HP Software, except and only to the extent that the right to do so is allowed
under applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information
you provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of
support services related to the Software or the HP Product. All such information will be subject to
HP’s privacy policy. HP will not use such information in a form that personally identifies you
except to the extent necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire
liability of HP and its suppliers under this EULA and your exclusive remedy under this EULA will
be limited to the greater of the amount actually paid by you for the Product or U.S. $5.00. TO
THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS
SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR
CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FOR LOST PROFITS, LOST DATA,
BUSINESS INTERRUPTION, PERSONAL INJURY, OR LOSS OF PRIVACY) RELATED IN
ANY WAY TO THE USE OF OR INABILITY TO USE THE SOFTWARE, EVEN IF HP OR ANY
SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND EVEN IF
THE ABOVE REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some states or other
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so
the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. Software was developed entirely at private expense. All
Software is commercial computer software within the meaning of the applicable acquisition
regulations. Accordingly, pursuant to US FAR 48 CFR 12.212 and DFAR 48 CFR 227.7202, use,
duplication and disclosure of the Software by or for the U.S. Government or a U.S. Government
subcontractor is subject solely to the terms and conditions set forth in this End User License
Agreement, except for provisions which are contrary to applicable mandatory federal laws.

10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)
applicable to the export or import of the Software, or (ii) restricting the Use of the Software,
including any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to
you in this EULA.

© 2009 Hewlett-Packard Development Company, L.P.

Rev. 04/09

OpenSSL
This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
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LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This
product includes software written by Tim Hudson (tjh@cryptsoft.com).

Customer support

Get telephone support, free during your warranty period, for
your country/region

Have the product name, serial number, date of purchase,
and problem description ready.

Country/region phone numbers are on the flyer that was in
the box with your product or at www.hp.com/support/.

Get 24-hour Internet product support and troubleshooting
and download drivers and software, and electronic
information

http://www.hp.com/go/support

Get support for products used with a Macintosh computer www.hp.com/go/macosx

Download software utilities, drivers, and electronic
information

http://www.hp.com/go/support

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register your product www.register.hp.com
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C Product specifications

● Physical specifications

● Power consumption, electrical specifications, and acoustic emissions

● Acoustic emissions

● Environmental specifications
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Physical specifications

Table C-1  Physical specifications

Product Height Depth Width Weight

HP Officejet Pro X451
MFP Series

380 mm (15.0 inches) 399 mm (15.7 inches) 513 mm (20.2 inches) With supplies: 23.7 kg
(50.0 lb)

Without supplies: 16.7
kg (16.8 lb)

HP Officejet Pro X551
MFP Series

414 mm (16.3 inches) 399 mm (15.7 inches) 513 mm (20.2 inches) With supplies: 23.7 kg
(50.0 lb)

Without supplies: 16.7
kg (16.8 lb)

Power consumption, electrical specifications, and
acoustic emissions

CAUTION: Power requirements are based on the country/region where the product is sold. Do not
convert operating voltages. This will damage the product and any such damage is not covered under
the HP limited warranty and service agreements.

Acoustic emissions
Table C-2  Acoustic emission levels

Operation LwAd-mono (B) LwAd-color (B) Notes

Print 6.9 6.8

Copy 7.1 6.9 ADF models

Scan 6.9 6.7 ADF models

HP recommends that the machine be located in a room in which no employee has his/her regular
work station.

Environmental specifications

Table C-3  Environmental specifications1

Operating Transporting

Temperature 15° to 30° C

(59° to 86° F)

–40° to 60° C

(–40° to 140° F)
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Table C-3  Environmental specifications1 (continued)

Operating Transporting

Relative humidity 20 to 80% 90% or less (non-condensing)

Altitude 0 to 3048 m (0 to 10,000 ft)  

Tilt IMPORTANT: This printer is designed
to be used on a level surface. Operating
the printer when not level could result in
inaccurate printer messaging about the
amount of ink remaining in cartridges.

 

1 Values are subject to change.
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D Environmental product stewardship
program

● Protecting the environment

● Ozone production

● Power consumption

● Paper use

● Plastics

● HP Officejet print supplies

● Return and recycling instructions

● Paper

● Material restrictions

● Disposal of waste equipment by users

● Electronic Hardware Recycling

● Chemical substances

● Material Safety Data Sheet (MSDS)

● For more information

● Substances Table (China)

● Restriction on Hazardous Substances statement (Turkey)

● Restriction on Hazardous Substances statement (Ukraine)

● Restriction on Hazardous Substances statement (Vietnam)

Protecting the environment
Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our
environment.

Ozone production
This product generates no appreciable ozone gas (O3).
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Power consumption
Power usage drops significantly while in Ready or Sleep mode, which saves natural resources and
saves money without affecting the high performance of this product. Hewlett-Packard printing and
imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S. Environmental
Protection Agency's ENERGY STAR specifications for imaging equipment. The following mark will
appear on ENERGY STAR qualified imaging products:

Additional ENERGY STAR qualified imaging product model information is listed at:

www.hp.com/go/energystar

NOTE: Additional energy savings may be realized by turning off the printer if it will not be used for a
longer time.

Paper use
This product’s optional automatic duplex feature (two-sided printing) and N-up printing (multiple
pages printed on one page) capability can reduce paper usage and the resulting demands on natural
resources.

NOTE: Recycled paper and A4 sized paper can be used for duplexing.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability
to identify plastics for recycling purposes at the end of the product’s life.

HP Officejet print supplies
HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP Officejet ink cartridges are
recycled properly, processing them to recover plastics and metals for new products and diverting
millions of tons of waste from landfills. Since this cartridge is being recycled and used in new
materials, it will not be returned to you. Thank you for being environmentally responsible!

NOTE: Go to http://www.hp.com/recycle for complete recycling information and to order postage-
paid labels, envelopes, or boxes, for recycling.
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Return and recycling instructions

United States and Puerto Rico
Go to www.hp.com/recycle for complete recycling information and to order post-paid labels and
envelopes or boxes. Please follow the applicable instructions below.

Multiple returns (more than one cartridge)

1. Package each HP Officejet ink cartridge in its original box and bag.

2. Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg
(70 lb).

3. Use a single pre-paid shipping label.

OR

1. Use your own suitable box, or request a free bulk collection box from www.hp.com/recycle or
1-800-340-2445 (holds up to 31 kg (70 lb) of HP Deskjet ink cartridges).

2. Use a single pre-paid shipping label.

Single returns

1. Package the HP Officejet ink cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

Shipping

For US and Puerto Rico HP Officejet ink cartridge recycling returns, use the pre-paid, pre-addressed
shipping label contained in the box. To use the UPS label, give the package to the UPS driver during
your next delivery or pick-up, or take it to an authorized UPS drop-off center. (Requested UPS
Ground pickup will be charged normal pick-up rates) For the location of your local UPS drop-off
center, call 1-800-PICKUPS or visit www.ups.com.

If you are returning the package with the FedEx label, give the package to either the U.S. Postal
Service carrier or FedEx driver during your next pick-up or delivery. (Requested FedEx Ground
pickup will be charged normal pick-up rates). Or, you can drop off your packaged ink cartridge(s) at
any U.S. Post Office or any FedEx shipping center or store. For the location of your nearest U.S. Post
Office, please call 1-800-ASK-USPS or visit www.usps.com. For the location of your nearest FedEx
shipping center/store, please call 1-800-GOFEDEX or visit www.fedex.com.

For more information, or to order additional labels or boxes for bulk returns, visit www.hp.com/recycle
or call 1-800-340-2445. Information subject to change without notice.

Residents of Alaska and Hawaii

Do not use the UPS label. Call 1-800-340-2445 for information and instructions. The U.S. Postal
Service provides no-cost cartridge return transportation services under an arrangement with HP for
Alaska and Hawaii.
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Non-U.S. returns
To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new product supply item) or visit
www.hp.com/recycle. Select your country/region for information on how to return your HP Officejet
printing supplies.

Battery disposal
For battery disposal information, see http://www8.hp.com/us/en/hp-information/environment/product-
recycling.html

Printer recycling
For printer recycling information, see http://www8.hp.com/us/en/hp-information/environment/product-
recycling.html

Paper
This product is capable of using recycled papers when the paper meets HP guidelines. This product
is suitable for the use of recycled paper according to EN12281:2002.

Material restrictions
This HP product does not contain intentionally added mercury.

This HP product contains a battery that might require special handling at end-of-life. The batteries
contained in or supplied by Hewlett-Packard for this product include the following:

HP Officejet Pro X451 and X551 MFP Series

Type Lithium Manganese Dioxide

Weight 3.0 g

Location On main board

User-removable No
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For recycling information, you can go to www.hp.com/recycle, or contact your local authorities or the
Electronics Industries Alliance: www.eiae.org.

Disposal of waste equipment by users
This symbol means do not dispose of your product with your other household waste. Instead, you
should protect human health and the environment by handing over your waste equipment to a
designated collection point for the recycling of waste electrical and electronic equipment. For more
information, go to http://www.hp.com/recycle

Electronic Hardware Recycling
HP encourages customers to recycle used electronic hardware. For more information about recycling
programs go to: http://www.hp.com/recycle.

Chemical substances
HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this
product can be found at: www.hp.com/go/reach.
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Material Safety Data Sheet (MSDS)
Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, ink)
can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
community/environment/productinfo/safety.
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For more information
To obtain information about these environmental topics:

● Product environmental profile sheet for this and many related HP products

● HP’s commitment to the environment

● HP’s environmental management system

● HP’s end-of-life product return and recycling program

● Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.

Substances Table (China)

Restriction on Hazardous Substances statement (Turkey)
Türkiye Cumhuriyeti: EEE Yönetmeliğine Uygundur
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Restriction on Hazardous Substances statement
(Ukraine)

Обладнання відповідає вимогам Технічного регламенту щодо обмеження використання деяких
небезпечних речовин в електричному та електронному обладнанні, затвердженого постановою
Кабінету Міністрів України від 3 грудня 2008 № 1057

Restriction on Hazardous Substances statement
(Vietnam)

“Các sản phẩm của công ty Hewlett-Packard tuân thủ Thông tư 30/2011/TT-BCT quy định tạm thời
về giới hạn hàm lượng cho phép của một số hóa chất độc hại trong sản phẩm điện, điện từ”
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E Regulatory information

● Regulatory Notices

● VCCI statement (Japan)

● Power cord instructions

● Power cord statement (Japan)

● EMC statement (Korea)

● GS statement (Germany)

● European Union Regulatory Notice

● Additional statements for wireless products

● Anonymous usage information storage

Regulatory Notices

Regulatory model identification number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The
Regulatory Model Number for your product is VCVRA-1212. This regulatory number should not be
confused with the marketing name (HP Officejet Pro X451 MFP Series, HP Officejet Pro X551 MFP
Series, etc.) or product numbers (CN459A, CN463A, CN596A, CV037A etc.).

FCC Statement
This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy. If this equipment is not installed and used in accordance with the
instructions, it may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

● Reorient or relocate the receiving antenna.

● Increase separation between equipment and receiver.

● Connect equipment to an outlet on a circuit different from that to which the receiver is located.

● Consult your dealer or an experienced radio/TV technician.
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NOTE: Any changes or modifications to the printer that are not expressly approved by HP could
void the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.

For further information, contact: Manager of Corporate Product Regulations Hewlett-Packard
Company 3000 Hanover Street Palo Alto, Ca 94304 (650) 857-1501

This device complies with Part 15 of FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

VCCI statement (Japan)

Power cord instructions
Make sure your power source is adequate for the product voltage rating. The voltage rating is on the
product label. The product uses either 100-127 Vac or 220-240 Vac and 50/60 Hz.

Connect the power cord between the product and a grounded AC outlet.

CAUTION: To prevent damage to the product, use only the power cord that is provided with the
product.

Power cord statement (Japan)

EMC statement (Korea)
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GS statement (Germany)
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt
nicht im unmittelbaren Gesichtsfeld platziert warden.

European Union Regulatory Notice
Products bearing the CE marking  comply with the following EU Directives:

● Low Voltage Directive 2006/95/EC

● EMC Directive 2004/108/EC

● Ecodesign Directive 2009/125/EC, where applicable

CE compliance of this product is valid only if powered with the correct CE-marked AC adapter
provided by HP.

If this product has wired and/or wireless telecommunications functionality, it also complies with the
essential requirements of the following EU Directive:

● R&TTE; Directive 1999/5/EC

Compliance with these directives implies conformity to applicable harmonized European standards
(European Norms) that are listed in the EU Declaration of Conformity issued by HP for this product or
product family and available (in English only) either within the product documentation or at the
following website: www.hp.com/go/certificates (type the product number in the search field).

The compliance is indicated by one of the following conformity markings placed on the product:

 For non-telecommunications products and for EU
harmonized telecommunications products, such
as Bluetooth® within power class below 10mW.

For EU non-harmonized telecommunications
products (If applicable, a 4-digit notified body
number is inserted between CE and !).

Please refer to the regulatory label provided on the product.

The telecommunications functionality of this product may be used in the following EU and EFTA
countries: Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France,
Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg,
Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden,
Switzerland, and United Kingdom.

The telephone connector (not available for all products) is intended for connection to analogue
telephone networks.

Products with wireless LAN devices

ENWW GS statement (Germany) 175



Some countries may have specific obligations or special requirements about the operation of
Wireless LAN networks such as indoor use only or restrictions of the channels available. Please
make sure that the country settings of the wireless network are correct.

France

For 2.4-GHz Wireless LAN operation of this product, certain restrictions apply: This product may be
used indoors for the entire 2400-MHz to 2483.5-MHz frequency band (channels 1 to 13). For outdoor
use, only the 2400-MHz to 2454-MHz frequency band (channels 1 to 7) may be used. For the latest
requirements, see www.arcep.fr.

The point of contact for regulatory matters is:

Hewlett-Packard GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen,
GERMANY

Additional statements for wireless products

FCC compliance statement—United States
Exposure to radio frequency radiation

CAUTION: The radiated output power of this device is far below the FCC radio frequency exposure
limits. Nevertheless, the device shall be used in such a manner that the potential for human contact
during normal operation is minimized.

In order to avoid the possibility of exceeding the FCC radio frequency exposure limits, human
proximity to the antenna shall not be less than 20 cm ( (8 in)) during normal operation.

Notice to users in the US and Canada
CAUTION: When using IEEE 802.11a wireless LAN, this product is restricted to indoor use, due to
its operation in the 5.15- to 5.25-GHz frequency range. The FCC/Industry Canada requires this
product to be used indoors for the frequency range of 5.15 GHz to 5.25 GHz to reduce the potential
for harmful interference to co-channel mobile satellite systems. High-power radar is allocated as the
primary user of the 5.25- to 5.35-GHz and 5.65- to 5.85-GHz bands. These radar stations can cause
interference with and/or damage to this device.

Australia statement
This device incorporates a radio-transmitting (wireless) device. For protection against radio
transmission exposure, it is recommended that this device be operated no less than 20 cm from the
head, neck, or body.

Brazil ANATEL statement
Este equipamento opera em caráter secundário, isto é, não tem direito à proteção contra
interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência a
sistemas operando em caráter primário (Res. ANTEL 282/2001).
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Canadian statements
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a
type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce
potential radio interference to other users, the antenna type and its gain should be so chosen that the
equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful
communication.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to
the following two conditions: (1) this device may not cause interference, and (2) this device must
accept any interference, including interference that may cause undesired operation of the device.

WARNING! Exposure to Radio Frequency Radiation The radiated output power of this device is
below the Industry Canada radio frequency exposure limits. Nevertheless, the device should be used
in such a manner that the potential for human contact is minimized during normal operation.

To avoid the possibility of exceeding the Industry Canada radio frequency exposure limits, human
proximity to the antennas should not be less than 20 cm (8 inches).

Japan statement

Korean statement

Taiwan statement
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Mexico statement
Aviso para los usuarios de México

La operación de este equipo está sujeta a las siguientes dos condiciones: (1) es posible que este
equipo o dispositivo no cause interferencia perjudicial y (2) este equipo o dispositivo debe aceptar
cualquier interferencia, incluyendo la que pueda causar su operación no deseada. Para saber el
modelo de la tarjeta inalámbrica utilizada, revise la etiqueta regulatoria de la impresora.

Anonymous usage information storage
The HP cartridges used with this printer contain a memory chip that assists in the operation of the
printer.

In addition, this memory chip stores a limited set of anonymous information about the usage of the
printer, which might include the following: the date when the cartridge was first installed, the date
when the cartridge was last used, the number of pages printed using the cartridge, the page
coverage, frequency of printing, the printing modes used, any printing errors that might have
occurred, and the printer model.

This information helps HP design future printers to meet our customers’ printing needs. The data
collected from the cartridge memory chip does not contain information that can be used to identify a
customer or user of the cartridge or their printer.

HP collects a sampling of the memory chips from cartridges returned to HP's free return and recycling
program (HP Planet Partners:www.hp.com/hpinfo/globalcitizenship/environment/recycle/). The
memory chips from this sampling are read and studied in order to improve future HP printers. HP
partners who assist in recycling this cartridge might have access to this data, as well.

Any third party possessing the cartridge might have access to the anonymous information on the
memory chip. If you prefer to not allow access to this information, you can render the chip inoperable.
However, after you render the memory chip inoperable, the cartridge cannot be used in an HP printer.

If you are concerned about providing this anonymous information, you can make this information
inaccessible by turning off the memory chip's ability to collect the printer's usage information:

To disable the usage information function

1. On the printer control panel, touch Setup.

2. Select Preferences, and then select Cartridge Chip Information.

3. Touch OK to turn off usage information collection.

NOTE: To re-enable the usage information function, restore the factory defaults.

NOTE: You can continue to use the cartridge in the HP printer if you turn off the memory chip's
ability to collect the printer’s usage information.
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F How do I?

● Connect the product on page 29

● Use the product with Windows on page 39

● Use the product with Mac on page 45

● Paper and print media on page 49

● Ink cartridges on page 59

● Print on page 71

● Color on page 101

● Manage and maintain on page 107

● Solve problems on page 117
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Index

A
accessories

ordering 153
acoustic specifications 162
AirPrint 95
anticounterfeit supplies 61

B
batteries included 168
bin, output

jams, clearing 129
locating 4, 5

booklets
creating (Windows) 91

C
canceling

print job 84, 92
cartridges

non-HP 61
recycling 61, 166
replacing 62
storage 61

cautions iii
change

ink cartridge 62
clean

control panel 116
cleaning

paper path 140
color

adjusting 101, 133
Colorlok technology 105
manage 101
matching 104
printed vs. monitor 104
printing in grayscale

(Windows) 84
using 101

color options
HP EasyColor (Windows) 103
setting (Windows) 81

Color tab settings 83
comparison, product models 1

connecting to a wireless network
35

connectivity
solving problems 144
USB 29

control panel
buttons 9, 11
clean control panel 116
help 11, 15
Home screen 10, 13
HP Web Services menu 21
menus 18
Reports menu 27
settings 41, 46

control panel, clean 116
conventions, document iii
copies

changing number of
(Windows) 73

counterfeit supplies 61
cover pages

printing (Mac) 82
printing on different paper

(Windows) 86
custom print settings (Windows)

73
custom-size paper settings

Macintosh 93
customer support

online 117, 159

D
default gateway, setting 32
defaults, restoring 119
Device setup menu 22
dimensions 162
disposal, end-of-life 168
document conventions iii
document feeder

locating 4, 5
door release, locating 4, 5
drivers

changing paper types and
sizes 50

changing settings (Mac) 46

changing settings (Windows)
41

presets (Mac) 81
settings 41
settings (Mac) 81
settings (Windows) 71
supported (Windows) 39
universal 41

duplex printing (double-sided)
settings (Windows) 77

duplex settings, changing 34

E
economy settings 114
electrical specifications 162
embedded Web server (EWS)

features 108
end-of-life disposal 168
environmental features 3
environmental specifications 162
ePrint

enabling or disabling 21
errors

software 149
ethernet port

locating 6, 7

F
factory-set defaults, restoring 119
fade- and water-resistant prints

105
features 2
firewall 35
first page

printing on different paper
(Windows) 86

use different paper 82
fonts

lists, printing 27
fraud Web site 61

G
gateway, setting default 32
General Office setting 61, 114
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grayscale
printing (Windows) 84

H
help

printing options (Windows) 72
help, control panel 11, 15
Home screen, control panel 10,

13
HP Customer Care 117, 159
HP Easy Color

disabling 103
using 103

HP Embedded Web Server 43
HP ePrint

description 34
enabling or disabling 21

HP ePrint Mobile Driver 94
HP ePrint, using 93
HP fraud website 61
HP Universal Print Driver 41
HP Utility 45, 46
HP Utility, Mac 45
HP Web Jetadmin 111
HP Web Services menu 21
HP Web Services, enabling 93
humidity specifications

environment 162

I
ink cartridges

checking for damage 139
non-HP 61
part numbers 59, 153
replacing 62
storage 61

input tray
loading 55
locating 4, 5

installing
product on wired networks 30
software, USB connections 29
software, wired networks 31

interface ports
locating 6, 7

IP address
obtaining 31

IPv4 address 32

J
jams

causes of 120
locating 121
output bin, clearing 129
paper path, clearing 127

Japanese VCCI statement 174
Jetadmin, HP Web 111

K
Korean EMC statement 174

L
labels

printing (Windows) 84
landscape orientation

selecting, Windows 80
last page

printing on different paper
(Windows) 86

left door
jams, clearing 127

license, software 156
link speed settings 34
loading paper

input tray 55

M
Mac

changing paper types and
sizes 93

driver settings 46, 81
HP Utility 45
problems, troubleshooting

150
removing software 48
supported operating systems

45
Macintosh

resize documents 93
support 117, 159

Macintosh driver settings
custom-size paper 93
watermarks 93

managing network 32
matching colors 104
material restrictions 168
Material Safety Data Sheet

(MSDS) 170

media
custom-size, Macintosh

settings 93
first page 82
pages per sheet 82
supported sizes 50

menu
control panel, access 18
Device setup 22
Network config 19
Service 26

menus, control panel
HP Web Services 21
Reports 27

mercury-free product 168
model

comparison 1
number, locating 8

models, feature overview 2
multiple pages per sheet 82

printing (Windows) 79

N
n-up printing 82

selecting (Windows) 79
network

configuring 19
password, changing 32
password, setting 32
settings, changing 32
settings, viewing 32

Network config menu 19
networks

default gateway 32
HP Web Jetadmin 111
IPv4 address 32
subnet mask 32

networks, wired
installing product 30

non-HP supplies 61
notes iii

O
obtaining

IP address 31
online help, control panel 11, 15
online support 117, 159
opening printer drivers

(Windows) 71
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operating environment,
specifications 162

operating systems supported 39,
45

ordering
supplies and accessories 153

ordering supplies
Web sites 153

orientation
selecting, Windows 80

output bin
jams, clearing 129
locating 4, 5

P
page sizes

scaling documents to fit
(Windows) 89

pages per sheet 82
selecting (Windows) 79

paper
covers, using different paper

86
custom-size, Macintosh

settings 93
default size for tray 57
first and last pages, using

different paper 86
first page 82
jams 120
pages per sheet 82
selecting 137
supported sizes 50

paper path
jams, clearing 127

paper pickup problems
solving 120

paper size
changing 50

paper sizes
selecting 76
selecting custom 77

paper type
changing 133

paper types
changing 50
selecting 77

paper, ordering 153
paper, special

printing (Windows) 84

PCL drivers 39
universal 41

PCL font list 27
PCL6 font list 27
physical specifications 162
Plug and Print USB Drive

printing 98
portrait orientation

selecting, Windows 80
ports

locating 6, 7
power

consumption 162
presets (Mac) 81
print cartridges

door release, locating 4, 5
recycling 61, 166

print job
canceling 84, 92
canceling, with Windows 84

print media
supported 50

print quality
improving 132, 133
improving (Windows) 76

print quality page
interpreting 65, 138
printing 65, 138

printer driver
configuring wireless network

36
printer drivers

choosing 140
printer drivers (Mac)

changing settings 46
settings 81

printer drivers (Windows)
changing settings 41
settings 71
supported 39

printing
from USB storage

accessories 98
settings (Mac) 81
settings (Windows) 71

printing on both sides
settings (Windows) 77

priority, settings 41, 46

problem-solving
no response 142
slow response 143

product
model comparison 1
serial number, locating 8

product overview 2
PS Emulation drivers 39
PS font list 27

R
recycling 3, 166

HP printing supplies returns
and environmental program
167

recycling supplies 61
removing Mac software 48
removing Windows software 43
reports

event log 108
network configuration page

108
PCL font list 108
printer status report 107
PS font list 108
quality report 107

Reports menu 27
resize documents

Macintosh 93
Windows 89

restoring factory-set defaults 119

S
scale documents

Macintosh 93
Windows 89

serial number, locating 8
Service menu 26
settings

driver presets (Mac) 81
drivers 41
drivers (Mac) 46
factory-set defaults, restoring

119
priority 41, 46

shortcuts (Windows)
creating 74
using 73

size 162
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software
embedded Web server 43
HP Utility 45
installing, USB connections

29
installing, wired networks 31
problems 149
settings 41, 46
software license agreement

156
supported operating systems

39, 45
uninstalling for Windows 43
uninstalling Mac 48
Windows components 39

solving
network problems 144
Plug and Print USB Drive

printing problems 143
USB direct-connect problems

144
special paper

printing (Windows) 84
specifications

electrical and acoustic 162
environmental 162
physical 162

standby
disabling 115
enabling 115

status
Home screen, control panel

10, 13
HP Utility, Mac 46

storing
environmental specifications

162
ink cartridges 61

subnet mask 32
supplies

counterfeit 61
non-HP 61
ordering 153
recycling 61, 166
status, viewing with HP Utility

46
support

online 117, 159
supported media 50

T
TCP/IP

manually configuring IPv4
parameters 32

technical support
online 117, 159

temperature specifications
environment 162

tips iii
Tray 1

jams, clearing 122
Tray 2

jams, clearing 125, 126
Tray 3

part number 153
trays

default paper size 57
jams, clearing 125, 126
locating 4, 5
selecting (Windows) 77

troubleshooting
checklist 117
jams 120
Mac problems 150
network problems 144
paper feed problems 120
Plug and Print USB Drive

printing problems 143
USB direct-connect problems

144
two-sided printing

settings (Windows) 77

U
uninstalling Mac software 48
uninstalling Windows software 43
universal print driver 41
USB

configuring wireless network
36

USB cable, part number 153
USB configuration 29
USB port

locating 6, 7
USB storage accessories

printing from 98

W
warnings iii

warranty
license 156
product 155

Waste disposal 169
watermarks 93

adding (Windows) 90
Web printing

HP ePrint 34
Web sites

customer support 117, 159
HP Web Jetadmin,

downloading 111
Macintosh customer support

117, 159
Material Safety Data Sheet

(MSDS) 170
ordering supplies 153
universal print driver 41

websites
fraud reports 61

weight 162
Windows

driver settings 41
drivers supported 39
software components 39
supported operating systems

39
universal print driver 41

wireless
configuring 19

wireless network
configuring with the setup

wizard 35
configuring with USB 36
configuring with WPS 35
installing the driver 36

wireless network connection 35
Wireless Setup Wizard

configuring wireless network
35

WPS
configuring wireless network

35
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Third-party licenses

LICENSE.aes-pubdom--crypto
---------------------
/* rijndael-alg-fst.c
 *
 * @version 3.0 (December 2000)
 *
 * Optimised ANSI C code for the Rijndael cipher (now AES)
 *
 * @author Vincent Rijmen <vincent.rijmen@esat.kuleuven.ac.be>
 * @author Antoon Bosselaers <antoon.bosselaers@esat.kuleuven.ac.be>
 * @author Paulo Barreto <paulo.barreto@terra.com.br>
 *
 * This code is hereby placed in the public domain.
 *
 * THIS SOFTWARE IS PROVIDED BY THE AUTHORS ''AS IS'' AND ANY EXPRESS
 * OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
 * WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
 * ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS OR CONTRIBUTORS BE
 * LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
 * CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
 * SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
 * BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
 * WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
 * OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
 * EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
 */

LICENSE.expat-mit--expat
---------------------
Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

LICENSE.hmac-sha2-bsd--nos_crypto
---------------------
/* HMAC-SHA-224/256/384/512 implementation
* Last update: 06/15/2005
* Issue date: 06/15/2005
*
* Copyright (C) 2005 Olivier Gay <olivier.gay@a3.epfl.ch>
* All rights reserved.
* 
* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions
* are met:
* 1. Redistributions of source code must retain the above copyright
* notice, this list of conditions and the following disclaimer.
* 2. Redistributions in binary form must reproduce the above copyright
* notice, this list of conditions and the following disclaimer in the
* documentation and/or other materials provided with the distribution.
* 3. Neither the name of the project nor the names of its contributors
* may be used to endorse or promote products derived from this software
* without specific prior written permission.
*
* THIS SOFTWARE IS PROVIDED BY THE PROJECT AND CONTRIBUTORS ``AS IS'' AND
* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
* PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE PROJECT OR CONTRIBUTORS
* BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
* CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
* SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
* BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
* WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
* OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
* ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
*/

LICENSE.open_ssl--open_ssl
---------------------
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.



This package is an SSL implementation written
by Eric Young (eay@cryptsoft.com).
The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as
the following conditions are aheared to. The following conditions
apply to all code found in this distribution, be it the RC4, RSA,
lhash, DES, etc., code; not just the SSL code. The SSL documentation
included with this distribution is covered by the same copyright terms
except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in
the code are not to be removed.
If this package is used in a product, Eric Young should be given attribution
as the author of the parts of the library used.
This can be in the form of a textual message at program startup or
in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:
1. Redistributions of source code must retain the copyright
 notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright
 notice, this list of conditions and the following disclaimer in the
 documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software
 must display the following acknowledgement:
 "This product includes cryptographic software written by
 Eric Young (eay@cryptsoft.com)"
 The word 'cryptographic' can be left out if the rouines from the library
 being used are not cryptographic related :-).
4. If you include any Windows specific code (or a derivative thereof) from
 the apps directory (application code) you must include an acknowledgement:
 "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
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ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publically available version or
derivative of this code cannot be changed. i.e. this code cannot simply be
copied and put under another distribution licence
[including the GNU Public Licence.]

====================================================================
Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
 notice, this list of conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright
 notice, this list of conditions and the following disclaimer in
 the documentation and/or other materials provided with the
 distribution.

3. All advertising materials mentioning features or use of this
 software must display the following acknowledgment:
 "This product includes software developed by the OpenSSL Project
 for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
 endorse or promote products derived from this software without
 prior written permission. For written permission, please contact
 openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"
 nor may "OpenSSL" appear in their names without prior written
 permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
 acknowledgment:
 "This product includes software developed by the OpenSSL Project
 for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR



ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.
====================================================================

This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com). This product includes software written by Tim
Hudson (tjh@cryptsoft.com).

====================================================================
Copyright (c) 1998-2006 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
 notice, this list of conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright
 notice, this list of conditions and the following disclaimer in
 the documentation and/or other materials provided with the
 distribution.

3. All advertising materials mentioning features or use of this
 software must display the following acknowledgment:
 "This product includes software developed by the OpenSSL Project
 for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
 endorse or promote products derived from this software without
 prior written permission. For written permission, please contact
 openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"
 nor may "OpenSSL" appear in their names without prior written
 permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
 acknowledgment:
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 "This product includes software developed by the OpenSSL Project
 for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.
====================================================================

This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com). This product includes software written by Tim
Hudson (tjh@cryptsoft.com).

====================================================================
Copyright 2002 Sun Microsystems, Inc. ALL RIGHTS RESERVED.
ECC cipher suite support in OpenSSL originally developed by 
SUN MICROSYSTEMS, INC., and contributed to the OpenSSL project.

LICENSE.sha2-bsd--nos_crypto
---------------------
/* FIPS 180-2 SHA-224/256/384/512 implementation
* Last update: 02/02/2007
* Issue date: 04/30/2005
 *
* Copyright (C) 2005, 2007 Olivier Gay <olivier.gay@a3.epfl.ch>
 * All rights reserved.
 *
* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions
 * are met:
* 1. Redistributions of source code must retain the above copyright
* notice, this list of conditions and the following disclaimer.
* 2. Redistributions in binary form must reproduce the above copyright
* notice, this list of conditions and the following disclaimer in the
* documentation and/or other materials provided with the distribution.
* 3. Neither the name of the project nor the names of its contributors



* may be used to endorse or promote products derived from this software
* without specific prior written permission.
 *
* THIS SOFTWARE IS PROVIDED BY THE PROJECT AND CONTRIBUTORS ``AS IS'' AND
* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
* PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE PROJECT OR CONTRIBUTORS
* BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
* CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
* SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
* INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
* CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
 * THE POSSIBILITY OF SUCH DAMAGE.
 */

LICENSE.zlib--zlib
---------------------
zlib.h -- interface of the 'zlib' general purpose compression library
version 1.2.3, July 18th, 2005

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable for any damages
arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,
including commercial applications, and to alter it and redistribute it
freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not
 claim that you wrote the original software. If you use this software
 in a product, an acknowledgment in the product documentation would be
 appreciated but is not required.
2. Altered source versions must be plainly marked as such, and must not be
 misrepresented as being the original software.
3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly Mark Adler
jloup@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for
Comments) 1950 to 1952 in the files http://www.ietf.org/rfc/rfc1950.txt
(zlib format), rfc1951.txt (deflate format) and rfc1952.txt (gzip format).
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LICENSE.md4-pubdom--jm_share_folder
---------------------
LibTomCrypt is public domain.  As should all quality software be.
  
All of the software was either written by or donated to  Tom St Denis for the purposes
of this project.  The only exception is the SAFER.C source which has no known
license status (assumed copyrighted) which is why SAFER,C is shipped as disabled.

Tom St Denis
 
LICENSE.md5-pubdom--jm_share_folder
---------------------
LibTomCrypt is public domain.  As should all quality software be.
 
All of the software was either written by or donated to Tom St Denis for the purposes
of this project.  The only exception is the SAFER.C source which has no known
license status (assumed copyrighted) which is why SAFER,C is shipped as disabled.
 
Tom St Denis
 
LICENSE.unicode--jm_share_folder
---------------------
Copyright 2001-2004 Unicode, Inc.
  
Disclaimer
This source code is provided as is by Unicode, Inc. No claims are
made as to fitness for any particular purpose. No warranties of any
kind are expressed or implied. The recipient agrees to determine
applicability of information provided. If this file has been
purchased on magnetic or optical media from Unicode, Inc., the
sole remedy for any claim will be exchange of defective media 
within 90 days of receipt. 
 
Limitations on Rights to Redistribute This Code 
 
Unicode, Inc. hereby grants the right to freely use the information 
supplied in this file in the creation of products supporting the 
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